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1 General Information

1.1 Overview

The Liberty Court Recording Solution is a system you can use to record up to 32 separate (mono) audio
streams onto a PC. A separate player provides playback facilities for the captured audio and video streams.

This is useful in a court setting. For example, you can place one microphone in front of each of four people and
record the court activities in four channels. During playback, you can listen to any of the four channels
individually. This allows courts to reduce the time spent managing the audio recordings of court proceedings. 

The following shows how a court reporter can use the Liberty Court Recording Solution to monitor the progress
of a recording, and add bookmarks at different points in the recording. 

1.2 What's New in Version 6.3?

Version 6.3 includes the following new features.

Liberty Court Recorder

• Support for Internet Protocol (IP) cameras.

• Support for the Picolo video card, which does on-board compression.

• Multiple camera feeds can be associated with a single room.

• Ability to include additional files when burning a CD/DVD.

• Video playback is now available.

• A new Help menu option lets you display the status of mirror operations.

• Removed the restriction on the screen resolution when using a Touch Screen View.

• View, copy associated links, and clear trace files as required.
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• Bookmarks can be printed in color.

• Ability to undo and redo operations when working with predefined bookmarks.

• When working with predefined bookmarks, you can open a past file of bookmarks from the File menu. 

Liberty Court Player

• Docket bookmarks can now be created from the Player.

• View, copy associated links, and clear trace files as required.

• Bookmarks can be printed in color.

• Bookmark titles from a recording file can be used instead of the titles defined in the Player’s configuration.

To obtain more detailed information about the features of the Liberty Court Recording Solution, review the “
Features” section.

1.3 Version Information

Version 6.3 February 2011

Liberty Court Recorder

• Support for Internet Protocol (IP) cameras.

• Support for the Picolo video card, which does on-board compression.

• Multiple camera feeds can be associated with a single room.

• Ability to include additional files when burning a CD/DVD.

• Video playback is now available.

• A new Help menu option lets you display the status of mirror operations.

• Removed the restriction on the screen resolution when using a Touch Screen View.

• View, copy associated links, and clear trace files as required.

• Bookmarks can be printed in color.

• Ability to undo and redo operations when working with predefined bookmarks.

• When working with predefined bookmarks, you can open a past file of bookmarks from the File menu. 

Liberty Court Player

• Docket bookmarks can now be created from the Player.

• View, copy associated links, and clear trace files as required.

• Bookmarks can be printed in color.

• Bookmark titles from a recording file can be used instead of the titles defined in the Player’s configuration.

Version 6.2 May 27, 2010

Liberty Court Recorder

• Support for Windows 7.

• Toolbar customization. For example, you can choose which buttons appear on a toolbar and the order in
which they appear.

• Work with multiple text-substitution shortcuts at once, such as to highlight them.

• An option to broadcast video without having the video saved as part of the recording file. 

• Replace text in file notes and bookmarks.

Liberty Court Player

• Support for Windows 7.
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• Toolbar customization. For example, you can choose which buttons appear on a toolbar and the order in
which they appear.

• Speed up access in listen-only mode when used with the NTFS file system. 

• Bookmarks and file notes are now available in listen-only mode.

• Replace text in file notes and bookmarks.

Version 6.0 August 12, 2009

Liberty Court Recorder

• Attach documents, such as evidence documents, to a recording file. You can open attachments, delete
attachments, seal/unseal attachments, and optionally include them when exporting recording files.

• Stream proceedings to a server which enables multiple users to view the proceedings in real time. 

• Configuration options can be exported and imported. This allows you to set up multiple computers with the
same configuration.

• Text substitution shortcuts can be exported and imported. This allows you to standardize on the shortcuts
being used.

• The interface is now compliant with Section 508 of the Rehabilitation Act.

• The ability to manually mirror a recording has been removed and replaced with the ability to burn a recording
onto CD or DVD. 

• Default values can be set for any of the docket fields. You can also choose which fields you want to use.

• When printing, the header and footer information is saved. You can also have the file name and print time
automatically inserted.

• The list of predefined bookmarks can be sorted alphabetically. 

Liberty Court Player

• You can open file attachments, delete attachments, seal/unseal attachments, and optionally include them
when exporting recording files.

• Configuration options can be exported and imported. This allows you to set up multiple computers with the
same configuration.

• The interface is now compliant with Section 508 of the Rehabilitation Act.

• When exporting a file to WAV or AVI format, you can select the media format from a drop-down list of past
values.

• When printing, the header and footer information is saved. You can also have the file name and print time
automatically inserted.

Version 5.2 March 7, 2009

Liberty Court Recorder

• Enhanced text substitution capabilities, including the ability to use abbreviations that allow you to quickly enter
any amount of predefined text, support for multi-line text, and the use of colors for text.

• Ability to specify a default folder to be used when creating and opening predefined-bookmarkfiles.

• Automatically load a predefined-bookmark file each time the Liberty Court Recorder program starts.

• A bookmark can be assigned a color, which allows you to highlight or classify bookmarks. For example, you
can use different colored bookmarks to differentiate child witnesses, sensitive information, etc.

Liberty Court Player

• Export a file, including bookmarks, audio, and video to PDF format. The media file can be created and saved
separately from the PDF document so that the audio/video links will work properly after you move the file onto a
Windows Media Server folder to be streamed to the end users. 

• Export a dcr file as a Windows Media file (wma, wmv).
• A bookmark can be assigned a color, which allows you to highlight or classify bookmarks. For example, you
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can use different colored bookmarks to differentiate child witnesses, sensitive information, etc.

Version 5.1 May 25, 2008

Liberty Court Recorder

• Support for Windows Vista.

• The SPEEX codec is now used for the default sound quality of recordings.

• When mirroring to CD in ISO format, the Recorder burns the CD itself without the use of a system burning
wizard (Windows XP and Vista only).

• When mirroring to CD in UDF format, the Recorder can automatically format a blank disc (Windows Vista
only).

•  Improvements in capturing and managing trace data.

• Tooltips are now available in the Touch Screen Full View and the Touch Screen Control View. 

• Visual styles in Windows XP and Windows Vista are now supported, which allow you to change the visual
style of the user interface.

• The font specified in your system properties is now applied to the Liberty Court Recorder program.

• The program is now packaged as an MSI file and uses the Windows Installer for installation.

Liberty Court Player

• Support for Windows Vista.

• The "Go to End" button has been added to allow a user to quickly go to the end of a recording.

• A new utility is available within the Player to check the integrity of a DCR file.

• When exporting a file to an audio CD, the Player burns the CD itself without the use of a system burning
wizard (Windows XP and Vista only).

•  Improvements in capturing and managing trace data.

• You can open a file in listen-only mode, which allows you to listen to a file but prevents you from making any
updates.

• Tooltips are now available in the Thin View. 

• Visual styles in Windows XP and Windows Vista are now supported, which allow you to change the visual
style of the user interface.

• The font specified in your system properties is now applied to the Liberty Court Player program.

• The program is now packaged as an MSI file and uses the Windows Installer for installation.

Version 5.0 July 3, 2007

Liberty Court Recorder

• Ability to restore a predefined bookmark when a case is stood down.

• Many improvements have been made to the search facilities:  

• When searching for text in DCR files, you can search files and docket-specific fields, search by date or a
date range, search for an exact phrase, specify a list of folders to search, use a phonetic algorithm, and
other enhancements. The search results are displayed as a list of files and a list of dockets.

• When searching for text within the current file, you can search for an exact phrase or as separate words,
search all text areas, and use a phonetic algorithm.

• Date and time can be included on each video frame.

• When the process of mirroring a recording to a CD is stopped, a new button allows you to close the current
file and eject the CD.

• Additional data, such as the user that made the recording, the product version, and other product information
can be displayed as part of a file's properties.

• A confirmation alert can be issued when you try to create a new file and another file is already open.

• Improved behavior in how separators are marked as used.
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• A desktop shortcut for this program can be automatically created during installation time.

Liberty Court Player

• Export the audio data from a DCR file directly to an audio CD. Previously, you would need to convert the DCR
file into a WAV file and then use CD-burning software to write the data to a CD. To avoid creating a very large
file and to facilitate playback, you can have the file automatically split based on bookmarks or file size (in
minutes). 

• A desktop shortcut for this program can be automatically created during installation time.

Version 4.5 November 18, 2006

Liberty Court Recorder

• A Plaintiff field has been added for dockets.

• More granular settings for the data which is included when printing bookmarks, exporting bookmarks to a text
file, or copying bookmarks to the clipboard. 

• When you use a predefined bookmark, you can use a visual indication the bookmark has been used.

• Improvements to the Predefined Bookmarks window include the following:

• Appending a file to the file you currently have open allows you to merge files together.

• Customize the way the list of bookmarks appears by inserting a separator, moving a bookmark up or
down, or highlighting the background color used for a bookmark.

• Move, highlight, or delete multiple bookmarks all at once.

• A main toolbar provides quick access to common operations such as creating a new bookmark or docket,
opening a file, and customizing the list of bookmarks.

• Additional menu options are now available allowing you to perform all operations using menu items.

• A shortcut menu allows you to create a new bookmark or docket bookmark, insert a separator, delete a
bookmark, highlight a bookmark, and insert a bookmark into a recording.

• Improvements to the Text Substitution window include the following:

• A main toolbar provides quick access to common operations such as creating a new shortcut,
rearranging the list of shortcuts, and inserting text.

• Additional menus are now available allowing you to perform all operations using menu items.

• A shortcut menu allows you to create a new shortcut, delete a shortcut, and insert text.

• Another touch screen view, called Touch Screen Control View, is available. This allows you to quickly and
easily start recording.

• Support for special characters and symbols in the fields used for bookmarks and dockets, and when using
such features as find in files and text substitution.

• Ability to stop a search when searching files for text.

Liberty Court Player

• A Plaintiff field has been added for dockets.

• More granular settings for the data which is included when printing bookmarks, exporting bookmarks to a text
file, or copying bookmarks to the clipboard. 

• A Selection panel has been added to the main Liberty Court Player window. On this panel, you can use a
slider and other controls to select part of a recording. This is particularly useful when you want to export only
part of a file.

• Online playback allows you to play back a file as it is being mirrored.

• Support for special characters and symbols in the fields used for bookmarks and dockets, and when using
such features as find in files and find in notes.

• Ability to stop a search when searching files for text.

Version 4.4 July 12, 2006
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Liberty Court Recorder

• Ability to lock or seal all, or parts, of a recording.

• Ability to write to CDs in ISO-data format when mirroring a recording after it has completed.

• Multiple copies of a CD can be made when mirroring a recording.

• The remote monitoring feature enables you to use the Liberty Network Monitor program to monitor the activity
(both sound and video) in up to four court rooms. You can add bookmarks and dockets, record new files,
append to existing files, and playback the current recording.

• Ability to change the columns that are displayed, their titles, and the order in which they appear when working
with bookmarks, dockets, and predefined bookmarks, and when using Liberty Definition Editor.

• Support for a touch-screen view that makes it easier for you to use a touch screen.

• At installation time, you can indicate that users without Administrator privileges have "Read-only" access and
are not allowed to change the program's configuration options.

• Customizable headers and footers can be used when printing.

• Additional start-up options to start Liberty Court Recorder when Windows starts and to load a new file when
Liberty Court Recorder starts.

• Ability to search for text in the Speaker field.

• Notification via an audible tone can take place when sound is absent in all channels.

• In the Predefined Bookmarks window, there is now an indication (grayed icon) that a predefined bookmark
has been used. 

• New menus are available for working with predefined bookmarks.

• Liberty Court Recorder can be minimized to the Thin View.

Liberty Court Player

• Ability to change the bookmark columns that are displayed and the order in which they appear, and the
names of the docket bookmark fields.

• Export sealed recordings with a password or to an unsealed format.

• Customizable headers and footers can be used when printing.

• Liberty Court Player can be minimized to the Thin View.

Version 4.3 December 29, 2005

Liberty Court Recorder

• Support for predefined bookmarks that you can define in advance and then later insert them into your actual
recordings.

• A new program, Liberty Definition Editor, allows you to predefine bookmarks on a PC on which  Liberty Court
Recorder is not installed.

• A file search facility lets you search for text, times, and dates across files.

• Improvements in the use of text-substitution shortcuts that allow you quick access to your predefined
shortcuts.

• 2-character channel names can be used in place of the channel numbers.

• A script can be automatically run when creating a new docket.

• A new file can be automatically created for each new docket.

• Bookmarks now contain a Speaker field.

• Ability to set the font used in bookmarks and notes.

• Show/hide different fields in the Bookmarks window.

• Ability to enhance the volume levels during playback.

• Liberty Court Recorder can automatically complete the mirroring process for files that were unsuccessfully
mirrored. 

• An Alert pop-up message can be issued when there are low sound levels on all recording channels.
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• You can select the channels for playback as the file is monitored in a PA System.

• A command-line interface lets you use your system scheduler to schedule a recording.

• Support for read-only files. Users can open and play read-only files but are unable to edit them.

• Ability to disassociate DCR files with this program.

Liberty Court Player

• Sound quality improvements using Automatic Gain Control (AGC).

• A file search facility lets you search for text, times, and dates across files.

• An audio tone can be issued when the playback of a recording is stopped or paused.

• 2-character channel names can be displayed in place of the channel numbers.

• Both absolute and relative times can be displayed in the Thin View.

• When exporting a segment of a file, you can select the segment based on absolute times.

• Bookmarks now contain a Speaker field.

• Ability to set the font used in bookmarks and notes.

• Show/hide different fields in the Bookmarks window.

• Automatically step-back a specified number of seconds when releasing your foot pedal during fast-forward
operations.

• Support for read-only files. Users can open and play read-only files but are unable to edit them.

• Ability to disassociate DCR files with this program.

Version 4.2 August 08, 2005

Liberty Court Recorder

• Support for compressed video, thereby providing support for additional cameras.

• Maximum frame rate for video recording has increased from 20 fps to 30 fps.

• Standard camera controls can be used to adjust the quality of video recordings, including brightness,
contrast, and saturation.

• Support for display clocks from Applied Technical Systems.

• Printing options for bookmarks and file notes allow you to add a title, change the font, print page numbers,
and preview the printed output.

• A Thin view reduces the main window to show only the channel recording levels.

• Special bookmarks, called dockets, can be used to distinguish cases within the same file.

• Advanced settings for video codecs, as determined by your compressor.

• New options for previewing video, including zoom and fit-in-window features.

• Hide/show PA System area of the main window.

• Optionally, have the File Notes window automatically displayed when opening files.

Liberty Court Player

• Suppress the level of noise and adjust the tone when playing files.

• Export captured video as an AVI file.

• Optionally, include video data and file notes when exporting a file.

• Ability to open files from the Thin View.

• Rewind files using a foot control.

• Printing options for bookmarks and file notes allow you to add a title, change the font, print page numbers,
and preview the printed output.

• Optionally, have the File Notes window automatically displayed when opening files.

• Liberty Court Player is installed as a common application where options can be set for each user or shared
amongst multiple users of the same computer.
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Version 4.1 June 11, 2005

• Introduced additional user controls for devices that do not support the standard Windows mixer.

Version 4.0 May  3, 2005

Internal release only.

Version 3.0 April 15, 2005

Liberty Court Recorder

• Video recording.

• Shortcut keys allow you to quickly insert predefined text into bookmarks and file notes.

• New options for mirroring recordings let you initiate the mirror process manually, write the mirrored file to CD,
and test the ability to write to the location specified.

• File notes and bookmarks can be exported as a text file, copied to the clipboard, or printed.

• Activate a clock display to indicate actual recording periods.

• Optional confirmation prompts for stopping and pausing a recording.

• Tailor the display of bookmark information by showing/hiding different fields.

Liberty Court Player

• Video playback.

• Ability to adjust the levels of individual channels.

• Export a selected area of a file instead of the entire file.

• Ability to search for text within file notes.

• Export file notes to a text file.

• File notes and bookmarks can be copied to the clipboard or printed.

• Tailor the display of bookmark information by showing/hiding different fields.

Version 2.0 November 16, 2004

Liberty Court Recorder:

• Playback of recordings in both WAVE and ASIO modes.

• Playback dialog allows you to play parts of the current file being recorded without using Liberty Court Player.

• Mirroring of recordings onto local/network disks.

• Indicators for active channels.

• Private notes can be used in bookmarks, and optionally excluded when exporting a bookmark to a text file.

• Synchronize time between your PC and a digital display clock.

• Use of a PA system for playing recorded sound to an output audio device.

• Keeping of time points using auto-bookmarks during a recording.

Liberty Court Player

• Export to a WAV or DCR file with any combination of channels.

• Export bookmarks or parts of bookmarks to a text file.

• Import bookmarks and file notes from BMR files created with Liberty Notes or Liberty Word-Notes.

• Search capability for text within bookmarks.

• Indicators for active channels.

• Private notes can be used in bookmarks, and optionally excluded when exporting a bookmark to a text file.

• Jump-to-time feature during playback allows easy navigation within a file.

• Retain last position in a file when it is closed and restore it when loading.
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• Preserve tone automatically during high-speed playback.

Version 1.2 July 14, 2004

• Ability to record in ASIO (Audio Streaming Input-Output) mode for devices with a corresponding ASIO driver.

• Ability to play any combination of channels.

• Extended program priority settings that can help provide cleaner recordings.

Version 1.1 March 17,  2004

The version was released.

1.4 Components and Requirements

Liberty Court Recording Solution is composed of both software and hardware.

The software components are the Liberty Court Recorder and the Liberty Court Player.

The Liberty Court Player is a no-cost download, available from High Criteria Inc.’s web site, and provides in-
the-courtroom playback on the same PC on which the Recorder is active. The Player allows users to access
and listen to individual channels within a Liberty Court Recorder file (i.e. a .dcr file). Any combination of
individual channels may be selected during playback. The Liberty Court Player can also be used to export a .
dcr file into another .dcr file, or to a mono .wav file that may be played with other players such as Windows
Media Player.

The software and hardware requirements are described below. Contact High Criteria Inc. for further
assistance.

Liberty Court Recorder
The minimum computer requirements for using the Liberty Court Recorder and associated multi-channel
sound cards are:

• Standard PC or laptop with the Windows XP SP2 operating system or later.

• 2GHz Processor or faster.

• 256MB Memory (RAM) or greater.

• An appropriate connection port (USB 2.0 or Firewire) or an available PCI slot, as determined in conjunction
with your Liberty sales representative.

• A standard Windows-compatible mono sound card with headphones, if you want to listen to sound files and
monitor recording levels as the files are being recorded.

• Sufficient hard-drive space to save the audio recording files.

• The Liberty Court Recorder supports a number of different multi-channel sound cards through industry
standard interfaces. Support includes WAV devices (including WDM) and ASIO devices. Consult High Criteria
or your Liberty dealer for more information about suitable sound cards to address your requirements.

• You must also provide sufficient storage capacity to retain the recordings, either on your local computer or on
a central data repository.

The multi-channel wav files created by the Liberty Court Recorder are standard computer files and can be
moved, copied and saved, just as any other computer file. Liberty Court Recorder includes a data mirroring
capability that provides a backup of your data files.

Liberty Court Player
The minimum computer requirements for using the Liberty Court Player are:

• A standard PC or laptop with the Windows 2000 operating system or later.
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• A standard Windows-compatible mono sound card with headphones or speakers that will be used for audio
playback.

• Optionally, playback can be controlled using a VEC Infinity USB foot-pedal. You can obtain this pedal from a
third party vendor or from High Criteria and associated Liberty dealers.

1.5 Features

Some of the features of the Liberty Court Recording Solution are listed below:

Liberty Court Recorder

• Supports recording in ASIO (Audio Streaming Input-Output) mode for devices with a corresponding ASIO
driver.

• Supports recording in Windows mode for standard Windows audio devices.

• Supports video recording using a video camera or an IP camera.

• Multiple camera feeds can be associated with a single room.

• Attach documents, such as evidence documents, to a recording file. You can open attachments, delete
attachments, seal/unseal attachments, and optionally include them when exporting recording files.

• Stream proceedings to a server which enables multiple users to view the proceedings in real time.

• Burning of a recording onto CD or DVD. You can burn the complete file or an individual disc and optionally
include additional files.

• Playback of recordings in both WAVE and ASIO modes.

• Playback dialog allows you to play parts of the current file being recorded without using Liberty Court Player.

• Supports up to 32-channel recording.

• Channel names can be assigned and used in place of channel numbers.

• Meters show the level of a recording being made onto the appropriate media.

• Indicators for active channels.

• Ability to listen to a recording as it is being made.

• Create new files or append to existing files.

• Mirroring of recordings onto local disks, network disks, and CDs.

• Keeping of time points using auto-bookmarks during a recording.

• Two touch-screen views allow you to control activity from a touch screen.

• An assistive view is available to comply with Section 508 of the Rehabilitation Act.

• Synchronize time between your PC and a digital display clock.

• Use of a PA system for playing recorded sound to an output audio device.

• Bookmarks allow you to navigate quickly in a sound file and store notes at chosen positions in a sound file.

• Special bookmarks, called dockets, can be used to distinguish cases.

• Docket information can be written to an ODBC-compliant database.

• You can use sealed bookmarks to seal all, or parts, of a recording.

• Bookmarks can be defined in advance and later inserted during the actual recording process.

• A bookmark can be assigned a color, which allows you to highlight or classify bookmarks. For example, you
can use different colored bookmarks to differentiate child witnesses, sensitive information, etc.

• The Liberty Definition Editor program allows you to predefine bookmarks on a PC on which Liberty Court
Recorder is not installed.

• The Liberty Network Monitor program allows you to monitor the activity (both sound and video) in up to four
court rooms. You can add bookmarks and dockets, record new files, append to existing files, and playback the
current file being recorded.

• Shortcuts allow you to quickly insert predefined text into bookmarks and file notes using either key
combinations or abbreviations.

• File notes can be added to a recording file, and include both notes and private notes.
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• File notes and bookmarks can be exported as a text file, copied to the clipboard, or printed. You can choose
which data fields to include.

• Alert notification for a paused recording and when there is a low level of sound in all channels.

• Configuration settings and text-substitution shortcuts can be exported and imported.

• Specification of valid file name formats.

• A file search facility lets you search for text across files and within dockets.

• Support for special characters and symbols that don't appear on your keyboard. 

• A command-line interface can be used to initiate a recording.

Liberty Court Player

• Playback of audio and video recordings, including a file that is currently being mirrored.

• Ability to work with file attachments. You can open attachments, delete attachments, seal/unseal attachments,
and optionally include them when exporting recording files.

• Bookmarks allow you to navigate quickly in a sound file and store notes at chosen positions in a sound file.

• A bookmark can be assigned a color, which allows you to highlight or classify bookmarks. For example, you
can use different colored bookmarks to differentiate sensitive information.

• File notes can be added to a recorded file.

• An assistive view is available to comply with Section 508 of the Rehabilitation Act.

• Private notes can be used in bookmarks, and optionally excluded when exporting a bookmark to a text file.

• File notes and bookmarks can be exported as a text file, copied to the clipboard, or printed. You can choose
which data fields to include.

• Export sealed recordings with a password or to an unsealed format.

• Preserve tone automatically during high-speed playback.

• Search and replace capability for text within bookmarks.

• Ability to play any combination of one or more channels.

• Export a file, or part of a file, directly to an audio CD.

• Export a file, or part of a file, to a WMA/WMV, WAV, AVI or DCR file with any combination of channels, and
optionally with video.

• Export a file, including bookmarks, audio, video, and attachments to PDF format. The media file can be
created and saved separately from the PDF document so that the audio/video links will work properly after you
move the file onto a Windows Media Server folder to be streamed to the end users. 

• Indicators for active channels.

• Configuration settings can be exported and imported.

• Jump-to-time feature during playback allows easy navigation within a file.

• Retain last position in a file when it is closed and restore it when loading.

• A foot pedal can be used for playback.

• A file search facility lets you search for text across files and within dockets.

1.6 Implementation Steps

This section describes the high-level steps to implement the Liberty Court Recording Solution.

At minimum, you should take the following steps:

1. Install the hardware.

2. Install the Liberty Court Recorder program. Refer to “Installing the Liberty Court Recorder”.

3. Install the Liberty Court Player program. Refer to “Installing the Liberty Court Player”.

Liberty Court Recorder and Liberty Court Player use the Image Mastering API from Microsoft to burn CDs. This
API is included as part of Windows Vista. For Windows XP users, you must install this API separately if you
plan to write files to data CDs in ISO format or export files to audio CDs. You can download it by searching the
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Internet for: WindowsXP-KB932716-x86-ENU.exe.  

1.7 Trademarks and Copyright Rights

Other product and company names appearing in High Criteria Inc. products and materials are used for
identification purposes only and may be trademarks or registered trademarks of their respective companies.
Registered and unregistered trademarks used in any High Criteria Inc. products and materials are the
exclusive property of their respective owners.

1.8 Registering Liberty Court Recorder

After installing and verifying Liberty Court Recorder works properly, you should obtain a license file from High
Criteria or an authorized dealer. If the program is not licensed then your use of Liberty Court Recorder is limited
to 60 days.

To register Liberty Court Recorder:

1. Obtain a license file by following the instructions on High Criteria Inc.’s web site: www.LibertyRecording.com
,

2. Copy the license file to the same folder where you installed Liberty Court Recorder.

3. Rename the license file to regkey.bsh.

4. Restart Liberty Court Recorder. 

5. From the Help menu, click About, to check that the program is registered.

1.9 Installing the Liberty Court Recorder

Liberty Court Recorder is installed as a common application. It supports an "All Users" install to allow different
users to work with the program on the same computer.  At installation time, you can indicate that users without
Administrator privileges have "Read-only" access and are not allowed to change the program's configuration
options.

The Liberty Court Recorder program is packaged as an MSI file and uses the Windows Installer for installation.
To install the program, take the following steps:

1. Run the lcr63re.msi program.

2. Follow the instructions on the screen. 

If you receive a message during installation to stop Windows Indexing Service then take the following steps.

1. From the Control Panel, choose "Administrative Tools - Computer Management”.

2. In the Computer Management tree, choose “Services and Applications - Indexing Service”. 

3. Press the Stop button (black rectangle) in the toolbar to stop Indexing Service.

4. If you are installing Liberty Court Player on the same machine, you can install this program when the
installation of Liberty Court Recorder completes.

5. When the installation completes, restart Indexing Service by clicking "Indexing Service" in the Computer
Management tree, and then press the Start button on the toolbar.

Post-install Procedure
If you are upgrading from an earlier release and have DCR files stored in a directory on the machine where
Liberty Court Player or Liberty Court Recorder are installed, then take the following steps:

1. From the Control Panel, choose "Administrative Tools - Computer Management”.

2. In the Computer Management tree, choose “Services and Applications - Indexing Service”. 

3. Start a full scan of each of the directories where DCR are currently stored, as described below.

  a) In the console tree, under "Indexing Service – System", click "Directories". 

http://www.LibertyRecording.com
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  b) In the details pane, click the directory you want to scan. 

  c) On the "Action" menu, point to "All Tasks", click "Rescan (Full)" for a full scan of the selected directory, and
confirm you want to initiate a rescan. 

  d) Repeat steps a) to c) for each of the directories in the list.

For more information, refer to the Windows online help for Indexing Service.

1.10 Installing the Liberty Court Player

Liberty Court Player is installed as a common application. It supports an "All Users" install to allow different
users to work with the program on the same computer.

The Liberty Court Player program is packaged as an MSI file and uses the Windows Installer for installation. To
install the program, take the following steps:

1. Run the lcr63pe.msi program.

2. Follow the instructions on the screen. 

See also "Installing the Liberty Court Recorder".

1.11 Uninstalling the Liberty Court Programs

To uninstall Liberty Court Recorder:
• From the Windows Start menu, choose “Programs” – “Liberty Court Recorder” – “Program Maintenance”. On
the Program Maintenance window, select "Remove".

To uninstall Liberty Court Player:
• From the Windows Start menu, choose “Programs” – “Liberty Court Player” – “Program Maintenance”. On the
Program Maintenance window, select "Remove".

Alternatively, to uninstall any of the Liberty Court Programs, use “Start – Settings – Control Panel - Add/Remove
Programs”.

2 Using Liberty Court Recorder

2.1 Starting Liberty Court Recorder

To start Liberty Court Recorder:

• From the Windows Start menu, choose “Programs” – “Liberty Court Recorder” – “Liberty Court Recorder”. The
main Liberty Court Recorder window appears. For more information on the parts of this window, refer to “Using
Liberty Court Recorder” later in this document.

2.2 Stopping Liberty Court Recorder

To stop Liberty Court Recorder:

• From the main Liberty Court Recorder window, either select “File - Exit”, or click the X button in the upper right-
hand corner.
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2.3 Configuring Liberty Court Recorder

2.3.1 Configuring Liberty Court Recorder

To configure the system, you use the Liberty Court Recorder program to set configuration options. 
Note that you can export and import configuration options when setting up similar systems.

To set configuration options: 
• From the main Liberty Court Recorder window, select “View - Options”. A dialog appears from which you can
access different configuration options. You can select from the following:

Dialog Use this dialog to set options for

Recording Recording source, sound quality, channel names, confirmations,
notifications

Video Recording video

Playback Playback devices

New Files Creating new files

Mirroring Mirroring files to disk

Burning Burning files to other media

General Priority level, minimizing Liberty Court Recorder application, window
displays, behavior when program closes, temporary files

Hot Keys Setting hot keys

Clock Setting synchronization parameters when using a digital clock

StartUp Starting Liberty Court Recorder

Touch Screen Using a touch screen

Remote Monitoring Using Liberty Network Monitor for remote monitoring of court rooms

Security Enabling a recording to be sealed

Bookmark Titles Specifying titles for the columns on the Predefined Bookmarks window, and
for specifying which docket fields to use, the names of the docket fields, and
their default values

Predefined
Bookmarks

Working with predefined bookmarks

Broadcast Broadcasting a recording in real time

You can use the following buttons:

Button Function

OK Save your changes and exit the configuration dialogs.

Cancel Cancel all of your changes that have not been saved.

Apply Save your changes and keep the current dialog open.

Restore defaults Restore default settings for current dialog



Using Liberty Court Recorder 19

Copyright (C) 2004-2011 High Criteria, Inc.

Each of the configuration options is described in detail in the following sections.

2.3.2 Using the Recording Dialog

Use the Recording dialog to set options for recording.
When you select Recording, the following dialog appears.

Source – specifies devices and channels used for recording.

Number of channels – select the number of channels to be used for recording.
Type of driver – select a category for the devices used for recording. You can choose either "Wave
Devices” (Windows mode) or "ASIO Device". Windows mode includes support for devices referencing WDM
and MME. If your hardware platform supports both ASIO and Windows mode, it is recommended you choose
“ASIO Device”. 
If you select wave mode for recording, then the confidence monitoring and PA outputs of the recorder must also
be in wave mode. If you select ASIO mode for recording, then confidence monitoring and PA outputs may be
either ASIO or wave.
If you select "ASIO Device", you can press the "Advanced" button to select an option to test the ASIO device
when Liberty Court Recorder starts. The following dialog box appears.

By selecting the "Check ASIO device when program starts" check box, each time Liberty Court Recorder starts,
it will try to initialize the ASIO device and try to record something. You will be notified of any errors with this
process.

Recording Devices for Channels – click this button to specify the channels and devices. The dialog that
appears depends upon the number of channels and the type of driver you have selected. 

For example, with 4 channels using WAVE devices, the following dialog appears:
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Active channels - Select the channels to be used for recording.

Devices for channels - Select the device for recording the pair of channels to the left. For example, the first
selection is the device used for channels 1 and 2.

With 4 channels using an ASIO device, the following dialog appears:

Active Channels - Select the channels to be used for recording.

ASIO Device for Channels - Select the ASIO device for recording all of the channels.

ASIO Control Panel – Click this button to display the Control Panel for the ASIO device (if it exists). Refer to the
documentation for your hardware device for more information.

Channel names
You can choose to replace the channel numbers with 2-character names. These names will appear in place of
the channel numbers, such as in the channel selection buttons, in the display of recording levels, and so on.
The names you choose are stored as part of the actual recording. Optionally, the channel names can be
displayed when playing a file in Liberty Court Player. When you change the channel names, the changes take
effect for the next recording. 

To replace a channel number with a channel name, take the following steps:

1. Click the "Channel Names" button. The following dialog appears.
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2. Select the "Use channel names" check box. 

3. Select a channel in the list of available channels. 

4. In the "Channel name" field, specify the name you want to use for the selected channel. You can use 1 or 2
alphanumeric characters for this name.

5. Optionally, in the "Description" field, specify a description for this channel.

Sound quality
Use the “Change” button to change the sound file format and parameters for recording. A system dialog
appears with the sound formats and parameters that are available on your system. The default format is
SPEEX with attributes “16.6 kBit/s, 16.0 kHz, Mono, Q5”. 

Confirm when stopping recording
Clear the check box if you do not want to be prompted each time a recording stops.

Confirm when pausing recording
Clear the check box if you do not want to be prompted each time a recording pauses.

Notification
Press this button to select options for notifications during recording. The following dialog appears.
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Notification when recording is paused

When a recording is paused, notification may take the form of a tone being generated on your speakers, or the
Liberty Court Recorder icon on the task bar may be flashed.

Flash the icon in Task Bar – The Liberty Court Recorder icon will flash for 30 seconds in the task bar.

Generate a simple tone on the speaker – issue a simple tone. You can click the "Change" button and adjust
the tone settings on the dialog box shown below.

You can click the button to listen to the tone.
This method will not work if you are playing sound through your  sound card and your  card does not allow the
mixing of sounds.

Notification when sound or video is absent

Select the "Display pop-up message" check box if you want automatic notification when the audio signal is
absent in all channels during a recording. A pop-up warning message is issued whenever there is an
absence of sound in all channels for specified period. 
If this alert is activated, the user should confirm that the system hardware is connected, powered-on and
functioning properly. Regardless of the fact the alert has been issued, the Liberty Court Recorder will attempt to
continue recording across all channels and the user may continue by simply clicking OK on the alert Window
after the hardware setup has been confirmed.

For notification, you can use the "Duration of low levels in all channels before alert" field to specify the duration
of low levels (in seconds) before the alert notification is issued. You can use the "Duration of absence of video
stream" field to specify the duration of absence of video stream (in seconds) before the alert notification is
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issued.

2.3.3 Using the Video Dialog

Use the Video dialog to set options for video recording.
When you select Video, the following dialog appears.

Enable video capture from n sources – check this box to enable the capturing of video, and specify the
number of sources.

Select each source from the drop-down list below and specify the following:
Type of device – select either “Video camera” or “IP camera”.
Device – For a Video camera, select the camera from the drop-down list of eligible cameras below. For an IP
camera, click the Select button to select the camera. Use the Add button to add a camera to the list. When you
click OK, Liberty Court Recorder will attempt to initialize the camera to ensure it can be used with the program.

Resolution – select the resolution supported by your video-capture device.

Frame rate – select the number of frames per second.

If the video camera has more than one physical input, or supports more than one hardware path for data, then
the video-capture device contains the video crossbar. Click the Advanced button on the Video tab to select  the
pixel depth / compression and crossbar settings, as shown below.
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Crossbar–  lists the video crossbars available. Depending on the hardware, the video-capture device may
contain more than one instance of the video crossbar. Select the crossbar appropriate for your input source.

Input – select the input line from the list of available input connection lines.

Output – select the output line from the list of available output connection lines.

Advanced –  press this button on the “Crossbar properties” dialog box to set advanced configuration options.
The resulting dialog depends upon the specific video capture device you are using.

If you are using a Picolo device, click the Advanced button to select the pixel depth / compression, video
standard, and whether you want the image flipped vertically, as shown below.

Pixel depth / Compression – select the pixel depth/compression setting. The default is RGB 32.
Video standard – select the video standard to use. The default is “Auto Detect” which means the program will
try to detect the standard of the input video signal. If this standard cannot be detected, the NTSC standard will
be used.
Flip vertical – select this checkbox if you want to flip the top/down image. The need to select this check box
depends on the type of video renderer that is being used.

Save video in recording file – clear this check box if you do not want the video saved as part of the recording.
This gives you the option of broadcasting video without saving the video into the recording file.

Compression:

Compressor – select the compressor used when recording video, or select "None" for uncompressed format.

Quality – select the compression quality. The Quality setting for compression ranges from 0 to 100. This is a
relative range that controls the quality of the video recording. You should not change this setting unless
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advised to do so by Technical Support.

Key frame every n frames – select the key-frame rate (i.e. number of frames per key frame). The default is 5,
which means a key frame occurs every 5 frames. You should not change this default unless advised to do so
by Technical Support. 

Advanced – press this button in the Compression area of the Video tab to set advanced configuration options,
if your compressor supports additional options.

2.3.4 Using the Playback Dialog

Use the Playback dialog to set devices for playback, both for confidence monitoring and for use with a PA
system.
When you select Playback, the following dialog appears.

Confidence Monitoring
These options are for monitoring during the recording process to ensure the recording is actually being
recorded correctly.

Type of driver
Select the type of driver to use. The list of available devices depends on the type of driver you select. 

Device
For WAVE mode, select your audio device (sound card) for recording. If the setting is “system default”, then
Liberty Court Recorder uses the device specified in your system audio settings (e.g. Start - Settings - Control
Panel - Multimedia - Audio).
For ASIO mode, select one of the device channels. Confidence monitoring and PA system outputs can be
either ASIO or WAVE.

Use digital boost
If you want to boost the volume levels during playback, select this check box, and choose the amount of boost
from the drop-down list. 

PA System
These options are for playback using a PA System.

Type of driver
Select the type of driver to use. The list of available devices depends on the type of driver you select.
Device
For WAVE mode, select your audio device (sound card) for recording. If the setting is “system default”, then
Liberty Court Recorder uses the device specified in your system audio settings (e.g. Start - Settings - Control
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Panel - Multimedia - Audio).
For ASIO mode, select one of the device channels. Confidence monitoring and PA system outputs can be
either ASIO or WAVE.

Use digital boost
If you want to boost the volume levels during playback, select this check box, and choose the amount of boost
from the drop-down list. 

Advanced 
Use this button to display the “Advanced Playback Settings”. The dialog looks like this:

The Mixer device lets you control the volume of sound and other playback parameters. Many Wave devices have
associated Mixer devices. Normally, the default settings (i.e. “Use an associated mixer device” checked and
specified “Mixer device”) are sufficient. Some Wave devices do not have an associated Mixer device. You
should not choose the Mixer device of other Wave devices. Liberty Court Recorder will not work properly if you
choose an incorrect device.
A mixing device is available only in WAVE mode.

Use an associated mixer device
This box is checked if your Wave device has an associated Mixer device. The associated Mixer device appears
in the “Mixer device” field. You can uncheck this box if using the associated Mixer device results in problems.
This box is unchecked and the “Mixer device” field is grayed out if there is no associated Mixer device. 

Mixer device 
Select a mixer device only if a Wave device has incorrectly found an associated Mixer device.

Sound processing for playing all channels
Default settings are normally acceptable. Only change these settings under the advice of Technical Support.

2.3.5 Using the New Files Dialog

Use the New Files dialog to set options for the creation of new files. 
When you select New Files, the following dialog appears.
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Default folder for creating and opening files
Set a default folder for creating and opening files. Liberty Court Recorder can use the previously used folder as
the default (select “Last used folder”) or you can specify the default folder yourself (select “This folder” and
specify the location).
If you type in the name of a new folder then Liberty Court Recorder automatically creates this folder when you
click on the OK or Apply button.

File name prefix
Files are generated with names containing the date and time in the format yyyymmdd_hhmnss. Optionally,
specify a prefix for the automatically generated file names. Since this prefix is used as a prefix for file names,
restricted characters are based on Windows file name restrictions. An example of a file name is:
test_20051125_182614.dcr (timestamp, representing 18:26:14 on November 25, 2005, with a prefix of test).

Prompt for file name

Check this box if you want to be prompted for the file name and location when you initiate each recording. This
allows you to override the defaults for these options.

Confirm new file during a recording

Select this check box if you want a confirmation alert issued when you try to create a new file and another file is
already open. This helps prevent you from mistakenly creating a new file when you have a recording already in
progress.

Continuous recording 

Select this check box if you want recording to automatically continue when a new file is created (i.e. when
creating a new file for a new docket or when creating a new file during a recording). Otherwise, you must
manually resume recording.

Create New Docket

Use this section to identify options when you create a new docket

Create new file for each new docket – select this check box if you want a new file created each time a new
docket is created during a recording. When a user creates a new docket, the recording is stopped, the previous
file is closed, and the new docket is inserted into a newly created file. Recording will continue only if the
"Continuous recording" check box is selected above.

Use docket number in file name – select this check box if you want the docket number to be included as part
of the new file name. This number appears after the prefix and before the timestamp.

Call this script - select this check box if you want to run a script when a new docket is created. This is useful,
for example, if you want to use a script to write information into a database. Type the location of the script or

use the  button to locate the script. 
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When a new docket is to be created, Liberty Court Recorder executes the specified script, and passes to it the
docket information as a string in XML format. This string has the following fields:

Field Description

DOCKET node name for the XML document

DOCKNO Docket No.

JUDGE Judge

PLAINTIFF Plaintiff Attorney

PLAINMAN Plaintiff 

DEFENSE Defense Attorney

DEFENDANT Defendant

CMNT Comment

CRTMUTC Creation time in UTC format

CRTMLOC Creation time in Local Time Zone format

FLPATH Path to the DCR file

FLNAME Name of the DCR file

Confirm predefined docket bookmarks  - select this check box if you want the "New Docket" window to pop up
each time you insert a predefined docket bookmark into a recording.

2.3.6 Using the Mirroring Dialog

Use the Mirroring dialog to set options for mirroring files that you record onto disk. Files can be mirrored to a
local drive, a network drive, or a compact disc (CD).
When you select Mirroring, the following dialog appears:
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Enable Mirroring
Select this box to enable mirroring of the files you record.

When
Select when the mirroring will take place:
• During recording - mirroring process starts when the recording starts and continues to mirror the file as it is
being recorded.
• After recording has stopped - once the recording stops, the file is mirrored.

Where
Disk type – select the type of disk on which the mirrored file will be created. You can choose "Local", "Network",
or "CD".
In the “Folder” field, specify the full path of the folder where mirrored files are saved. The "Total Size" and "Free
Space" fields display information about the location you specify. For a compact disc, you can specify the
number of copies to make.

Test
Use this button to test that Liberty Court Recorder can write to the location specified and in the format you have
specified.

After successful mirroring and closing file

Choose options after a file has been successfully mirrored and closed.
Remove 'Archive' attribute - When you finish successfully a mirroring of a file, the attribute “Archive” for the
original file will be removed.
Delete source file - When you close a file that has been mirrored, it is automatically deleted.  A source file,
which has been mirrored, is also deleted if you close Liberty Court Recorder.

Advanced 
Use this button to display the “Advanced Mirroring Settings”. The dialog looks like this:
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If a file was not mirrored successfully, Liberty Court Recorder will try to complete the mirroring process in the
background. If you want to change this behavior, clear the option "Complete unsuccessful mirroring".

Liberty Court Recorder can mirror a recording after it has completed to an ISO-formatted CD. If you want to use
ISO format when mirroring to a compact disc, select "Use ISO-data format". You will also need to ensure that
CD recording for your drive has been enabled. You can also indicate you want to use UDF-format along with an
autoformat feature for blank CDs. For more information, see "Writing to Compact Discs".

2.3.7 Using the Burning Dialog

Use the Burning dialog to set options for burning files that you record onto other media, such as CD. 
When you select Burning, the following dialog appears:

Enable burning
Select this box to enable burning of the files you record.

When
Select when the burning will take place:
• Only manual burning – burning of a file takes place only when you initiate it through the "File – Burn to

CD/DVD" menu option or by clicking on the  button in the Status panel for an open file. 
• After recording has stopped - burning process starts when the recording has finished. A confirmation dialog
appears before the burning process actually starts.
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Where
Disk type – select the type of disc on which the file will be burned. You can choose "CD" or "DVD". 
In the “Drive” field, specify the name of the drive used to burn the media. 

Add files in this folder to the CD/DVD
Select this box if you want to include additional files when you burn a CD or DVD. Specify the location of the
folder containing these files in the field below. All files from this folder will be added to the disc. Note that only
files are added and not subfolders. The size of these files cannot exceed half of the available space on the
disc. If a recording spans multiple discs, these additional files are copied to each of the discs.

Advanced 
Use this button to display the “Advanced Burning Settings”. The dialog looks like this:

Multiple Discs
When creating multiple discs, Liberty Court Recorder will overlap a sound stream using the "Sound stream
overlap" setting. For example, when it creates the second disc, it will include the last 10 seconds from the first
disc, by default.

Format
By default, Liberty Court Recorder will burn recordings using ISO format.  This is the recommended setting. 

Optionally, you can choose to use UDF-format. When using UDF format, Liberty Court Recorder can
automatically format a blank CD to be used in the burning process. This feature requires all of the following:

• Liberty Court Recorder is running on Windows Vista.

• Your system settings related to what happens when you insert a blank CD or DVD should either be set to
"Take no action", or "Use AutoPlay for all media or devices" should be disabled.

• Liberty Court Recorder is run under the Administrators or Backup Operators group account, unless the User
Account Control is turned on. If the User Account Control is turned on, you should run Liberty Court Recorder
with the "Run as administrator" function, which is located in the pop-up menu and in the shortcut for the
program by going to "Properties - Shortcut - Advanced".

2.3.8 Using the General Dialog

Use the General dialog to set options for priority level, minimizing the Liberty Court Recorder application, the
windows to display, and the behavior when closing the program.
When you select General, the following dialog appears.
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Priority level
Choose the priority level of the Liberty Court Recorder program. You can use this setting to improve the system
resource utilization of the program. 
Select one of the following:
High - set the priority to the highest level.  
Above normal - set the priority at an intermediate level between "Normal" and "High". 
Normal - default priority.
Because sound recording is a real-time process, buffers can get out of sequence. This can lead to echoes
and other problems in a recording. The Priority level setting helps eliminate such problems and provides
cleaner recordings. If the default setting of “Normal” results in such problems, change the priority setting to
"Above normal". If problems arise at this setting, change the priority setting to "High". 
Note: If Liberty Court Recorder is not on a dedicated machine, it is recommended that high-utilization
applications such as virus checkers are not being run during a recording.

Minimize to
Choose the behavior when you minimize the Liberty Court Recorder application. Select one of the following:
Task Bar – appears minimized in the Task Bar. This is the normal behavior.
System Tray –  appears as an icon in the System Tray.
Thin View – display Liberty Court Recorder's Thin View, where only the channel recording levels are displayed.
For more information, see "Using the Thin View".

Automatically show File Notes window
Check this box if you want to have the File Notes window automatically displayed when opening a file that
contains file notes.

Automatically show Bookmarks window
Check this box if you want to have the Bookmarks window automatically displayed when opening a file that
contains bookmarks.

Behavior when program closes

You can select "Log off user" to log off the current user when you close the Liberty Court Recorder program, or
you can select "Shut down Windows" to shut down Windows when the program closes.

Advanced
Click the "Advanced" button if you want to specify a folder for temporary files. The size of a recording file can be
quite large. Because of this, the Liberty Court Recorder application saves recorded information in a temporary
file rather than in memory.
When you first start the Liberty Court Recorder application, it sets the folder for temporary files based on the
following:
• If the system environment variable TMP exists, it uses its value.
• Else, if the TEMP system environment variable exists, it uses its value.
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• Otherwise, it uses the folder where the application is installed.

2.3.9 Using the Hot Keys Dialog

Use the Hot Keys dialog to set hot keys for quick access to common commands.
When you select Hot Keys, the following dialog appears.

Enable Hot Keys
Check this box if you want to use global hot keys.

Setting Hot Keys
To change a hot key setting, take the following steps: 
1. Click on the item in the list of commands that you want to change.
2. In the “Press new key” box press the keyboard combination you want to use as a hot key.
3. Click OK or Apply.

You can use “Clear” to disable a hot key or “Clear All” to set all hot keys to “None”.
If any of these combinations is used by another active application or shortcut, the combination will not work
with Liberty Court Recorder.

2.3.10 Using the Clock Dialog

Use the Clock dialog to set options for synchronization with an outside clock device.
When you select Clock, the following dialog appears.
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Synchronize time with Display Clock
Check this box to synchronize time with an outside clock device.

Type of Display Clock
Select the type of display clock: Applied Technical Systems or Digital Display Systems.

Attached to port
Select the COM-port to which your clock device is connected.

Synchronization direction
Select the direction for synchronization:
• PC sets time on Display clock - display your PC’s time on the display clock. 
• Display Clock resets PC time – set your PC’s time from the clock device. In this case, you need to have
sufficient user rights in your operating system.

Activate time display when recording
Select this option if you want to use the clock to indicate recording status. If the clock time appears, recording is
taking place. If the clock time does not appear, recording has been turned off. 

2.3.11 Using the StartUp Dialog

Use the StartUp dialog to set options for the start of the Liberty Court Recorder application.
When you select Startup, the following dialog appears.

Minimize when program starts
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Check this box to minimize the main window after the Liberty Court Recorder application starts. The behavior
when you minimize is based on the minimize method you specify under View - Options – General. It can be
minimized to the task bar or to the system tray.

Load a file when program starts 
You can optionally select a file to be automatically loaded when Liberty Court Recorder starts. Choose one of
the following:
Load new file and use default file name – create a new file each time Liberty Court Recorder starts. The name
of the file is based on your "New Files" settings.
Load last-used file – load the file Liberty Court Recorder last used (either played/recorded).
Load this file – locate the specific file to be loaded.
If the file no longer exists, or has been moved, this has no effect.

Action
You can optionally start recording when the Liberty Court Recorder program starts, by selecting the "Start
recording" check box. To record for a specified period, specify the duration in hours (hh) and minutes (mm).
Optionally, select the "Close program when complete" check box to close Liberty Court Recorder when it has
recorded for the duration you have specified.

To have Liberty Court Recorder automatically start when Windows starts, select “Start program automatically
when Windows starts”.

2.3.12 Using the Touch Screen Dialog

Use the Touch Screen dialog to set options for using a touch screen with Liberty Court Recorder.
When you select Touch Screen, the following dialog appears.

With a touch screen, you can use either the Touch Screen Full view or the Touch Screen Control View.

Touch Screen Control view – touch screen view with only the controls available. This is useful when you just
want to record and don't require bookmarks or video. 

Touch Screen Full view – full-function touch screen view 

Use Touch Screen view 
Select this option to enable the use of a touch screen.

Hot key to switch between views 
The hot key combinations are used to switch between the different views: TS (Touch Screen) Full view, TS
(Touch Screen) Control view, and Standard view. The default hot key combinations are:

Hot Key Combination Switch to…
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Ctrl + Alt + F Touch Screen Full view

Ctrl + Alt + C Touch Screen Control view

Ctrl + Alt + S Standard view

To change a default: place your cursor in the box, press a key combination, and click “Apply”. The status
indicates whether this key combination is allowed.

Activate when program starts 
Select which Touch Screen view you want to appear each time Liberty Court Recorder starts.

See also "Using a Touch Screen View".

2.3.13 Using the Remote Monitoring Dialog

Use the Remote Monitoring dialog to set options that allow the use of remote monitoring and control using the
separately licensed Liberty Network Monitor program.

When you select Remote Monitoring, the following dialog appears.

Enable remote monitoring
Select this option to enable the remote monitoring facility.

Recorder's IP address
You may have more than one IP address on your PC. You must specify the IP address on this PC to use for
remote monitoring using one of these options:

Use IP address from list – select an IP address from the list of IP addresses for all adapters.

Use this IP address - if, for any reason, an IP address cannot be determined, specify the address to be used
for remote monitoring in the box to the right.

Listening port 
Specify the port on which Liberty Court Recorder listens for a remote PC being used to monitor and control
recordings.

2.3.14 Using the Security Dialog

Use the Security dialog to set options to enable the sealing of a recording or parts of a recording.
When you select Security, the following dialog appears.
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Enable security 

Select this option if you want to allow a recording or parts of a recording to be sealed. This allows you to use
special bookmarks, called sealed bookmarks.  Audio saved between a Begin Seal bookmark and an End Seal
bookmark will be encrypted and can only be played by supplying the appropriate password. 

See also "Working with Sealed Recordings".

When you enable security, the following dialog appears:

Specify Passwords

Complete the following password fields. Each password must be at least six characters long.

New Recording password – password used to seal data.

Confirm new Recording password – re-enter the recording password.

New Override password – an override password you need to supply if you want to change the current recording
password.

Confirm new override password – re-enter the override password.

Changing a Password 

It is not recommended you change a password. Previous recordings made with a different password will not
be playable using Liberty Court Recorder.  

You can change either the Recording password or the Override password by taking the following steps:

1. Click Change passwords. The Specify Passwords dialog box appears.

2. In the Old Recording or Override Password field, specify either the current recording password or the
override password. 

3. Select the password you want to change, enter the new password, and confirm the new password.
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2.3.15 Using the Bookmark Titles Dialog

Use the Bookmark Titles dialog to customize the column titles that appear on the Predefined Bookmarks
window, and for specifying which docket fields to use, the names of the docket fields, and their default values.

When you select Bookmark Titles, the following dialog appears.

Select the fields you want to use.
You can replace a default title by typing the new title in the corresponding text field in the “Title” column. 
You can specify a default value for any of the fields by typing the default value in the corresponding text field in
the “Default Value” column.

2.3.16 Using the Predefined Bookmarks Dialog

Use the Predefined Bookmarks dialog to specify options for working with predefined-bookmark files and to
specify indicators for used bookmarks in the Predefined Bookmarks window.
When you select Predefined Bookmarks, the following dialog appears.

Default folder for creating and opening files
Set a default folder for creating and opening predefined-bookmark files. Liberty Court Recorder can use the
previously used folder as the default (select “Last used folder”) or you can specify the default folder yourself
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(select “This folder” and specify the location).
If you type in the name of a new folder then Liberty Court Recorder automatically creates this folder when you
click the OK or Apply button.

Load a file when program starts 
You can optionally select a predefined-bookmark file to be automatically loaded when Liberty Court Recorder
starts. Choose one of the following:
Load last-used file – load the predefined-bookmark file Liberty Court Recorder last used.
Load this file – locate the specific file to be loaded.
If the file no longer exists, or has been moved, this has no effect.

When you insert a predefined bookmark into a recording, Liberty Court Recorder can visually indicate, in the
Predefined Bookmarks window, the bookmark has been used. You can choose any combination of the
following options: 

Grey button – change the button at the left of the bookmark in the Predefined window to the following: 

Demote bookmark – move the bookmark to the end of the unused bookmarks in the list. The order of used
and unused bookmarks depends on the order in which they appear in the file and does not depend on the
order in which you insert them. If you reset all of the usage indicators then all of the bookmarks are rearranged
to their original order. When a bookmark is demoted, all separator bookmarks that are directly below it in the
list of bookmarks are also demoted. 

Highlight background – highlight the used bookmark's background with the color you choose. Click the
“Change” button to choose the color you want to use for highlighting. 

When a bookmark is demoted, all separator bookmarks that are directly below it in the list of bookmarks are
also demoted. 

Bookmarks should inherit colors – select this option if you want to retain the color of a predefined bookmark
when you use it as a bookmark in your recording.

2.3.17 Using the Broadcast Dialog

Use the Broadcast dialog to set options for broadcasting, or streaming, a recording in real time. 
When you select Broadcast, the following dialog appears.

Use Broadcast feature – select this check box to enable a recording to be broadcasted, or streamed, in real
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time.

Push to server
Select this check box if you want the recorder to initiate the connection to a server running Microsoft Media
Server (MMS). This allows multiple users to monitor the same stream via Liberty Network Monitor. Specify the
“Server name” and “Publishing point” name, and click the “Log on as” button to specify a valid user name and
password that has permission to log on to the Microsoft Media server.

The default port number is 80. If the server is using a different port, specify the port number in the “Server
name” field. For example, "http://MyServer:8080" specifies port number 8080.

Pull from Recorder
Select this check box if you want a Microsoft Media server or player to initiate a connection to the recorder using
the HTTP protocol. This allows users to browse to the address of the recording machine to access the stream.
You can change the default port number of 8080.

Use multiple bit rates (MBR) - if selected, the video output consists of a single input encoded multiple times,
each with different bit-rate settings. When a file with MBR encoding is read, the reader will determine which
stream to use based on the available bandwidth.

Include video – if selected, the video data will be included in the broadcast. By default, all video sources will be
included. Click the “Select Video Source” button to restrict which sources are included.

Click the “Change Format” button to adjust format parameters. 

Start broadcasting when program starts – select this check box if you want to have broadcasting started
automatically when Liberty Court Recorder starts.

2.3.18 Exporting and Importing Configuration Options

You may want to set up similar Liberty Court Recorder systems with the same configuration options. From one
system, you can export the configuration options as a file and then import that file to another system.

To export all of your configuration options for Liberty Court Recorder, take the following steps:
1. From the main window, click Tools, and then Export Configuration Options.
2. Specify the name and location for the exported file.

To import configuration options to Liberty Court Recorder, take the following steps:
1. If you have a recording file open, you will need to close it.
2. From the main window, click Tools, and then Import Configuration Options.
3. Specify the name and location for the file containing the configuration options you want to import.
Once the file has been imported successfully, you must restart Liberty Court Recorder to continue to use it.

2.4 Using Liberty Court Recorder

Liberty Court Recorder allows you to have multiple windows open. By resizing and repositioning the windows
on your workspace, you can work with different windows simultaneously. The following shows one way of
organizing your workspace.  You can monitor the progress of a recording, add bookmarks (including
predefined bookmarks) at different points in the recording, and use text-substitution shortcuts.
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2.5 Liberty Court Recorder Main Window

The Liberty Court Recorder main window consists of different parts, as shown below:
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Liberty Court Recorder Menus
From the main Liberty Court Recorder window, you can use the following menus:

Menu Use this menu to …

File Create/open/close files, display file properties, burn a file, exit the program.

Audio Record, pause, stop, broadcast, display the ASIO Control Panel, play in real time, set
the channels being played, enable confidence monitoring and the use of a PA
system, enable channel-mixing mode for playback.

View Show/hide different options (i.e. toolbar, tooltips, always on top, PA System
information, confidence monitoring, etc), switch to a different type of view, customize
the font, customize the toolbars, and set configuration options.

Tools Display the Playback window, define text-substitution shortcuts, create and use
predefined bookmarks, find text in files, export/import configuration options.

Help Display online help, display program and registration information, activate the trace
facility.

Main toolbar
The toolbar allows you easy access to common operations. You can use the following buttons, and associated
menu items and shortcut keys on the default toolbar:
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Button Description Menu Shortcut Key

Create a new sound file. File  – New Ctrl + N

Open an existing sound file. File  – Open Ctrl + O

Change configuration options. View – Options Alt + F7

Show or hide the File Notes
window.

View – File Notes

Show or hide the Bookmarks
window.

View – Bookmarks Alt + F2

Show or hide the Video window. View – Video Preview

Switch to the Thin View. View – Thin View Alt + F5

Display Playback window Tools – Playback Window

Show or hide the Text
Substitution window.

Tools – Text Substitution

Show or hide the Predefined
Bookmarks window.

Tools – Predefined Bookmarks

Find data in files Tools – Find in Files

Status
This group displays status and length of the current file. You can select “File – Properties” for more information
about the current file.
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Record
You can use the following buttons, menus and shortcuts:

Button Description Menu Shortcut Key

Record Audio – Record Ctrl+R

Pause/continue Audio - Pause Ctrl+U

Stop Audio - Stop Ctrl+T

A meter for each of the channels being recorded shows the level of the recording for the associated channel.
This is the level of the recording being output to the recording media, and not the level of the input coming from
the microphones (although these levels should be the same if everything is working properly).

Customizing the Toolbars
You can customize the different toolbars used in Liberty Court Recorder. For example, you can choose which
buttons appear on the toolbar and the order in which they appear.

On the View menu, click Customize Toolbars. The following dialog box appears.
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To lock the toolbar to prevent it from being repositioned, select Lock toolbar.

To show/hide the toolbar, select/clear the Visible check box.

To add a toolbar button, select a button from the list of Available toolbar buttons, and then click Add.
Alternatively, you can drag-and-drop a button from one list to the other.

To remove a toolbar button, select a button from the list of Current toolbar buttons, and then click Remove.
Alternatively, you can drag-and-drop a button from one list to the other. 

To change the position of buttons on the toolbar, select a button from the list of Current toolbar buttons, and
then click Move Up or Move Down. 

To restore the toolbar buttons to their default settings, click Restore default.

You can also customize the toolbar by right-clicking the toolbar, and then clicking Customize.

2.6 Recording

Recording Video
If you want to record video as well as audio, use "View – Options – Video" to set your options for video
recording, and select “Enable video capture”. When you start to record, Liberty Court Recorder records video
and embeds it into the .dcr file it creates.

Starting a Recording

To record a sound file, click on the  button or select “Audio – Record”. The application starts to record the
file from the end position.

Viewing Video during a Recording

During a recording, you can display what is being captured on video. The  icon in the Action display
indicates video recording is enabled, as shown below.

To display the video being recorded, select "View – Video Preview", or press the  button on the main
toolbar. A separate window opens that you can drag around your screen as required.



Liberty Court Recording System46

Copyright (C) 2004-2011 High Criteria, Inc.

The Video Preview window looks like this:

The status bar shows the video device name, the current frame rate, and the current size of the video area. 

From the View menu, you can show/hide the status bar, zoom in and out, and adjust the video size to fit in the
window.

From the Settings menu, you can adjust the quality of the video, indicate whether the date and time should
appear, and where the date and time should appear.

Pausing a Recording

To interrupt a recording, click on the  button or select “Audio – Pause”. To resume a paused recording,

click on the   button or select “Audio – Pause”.

Stopping a Recording

To stop recording, click on the button or select “Audio – Stop”.

Creating a new bookmark during recording 
You can create bookmarks during a recording.
To create a new bookmark:

With the Bookmarks window open, click the  button on the bookmark toolbar, or from the Edit menu, click
New Bookmark.

2.7 Monitoring a Recording

Confidence monitoring of a recording allows you to listen to a recording as it is being made. You can
listen to any of the recording channels being used.
To set options for confidence monitoring, use “Options - Playback”. Then you can use the following dialog on
the main window to use confidence monitoring.

Confidence monitoring during recording
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Click the “Enable” box, if you want to play your recording as it is being made. This allows you to determine that
the recordings are being made onto the appropriate media and that they are at a level of loudness sufficient to
be easily understood during playback. 

The slider in this section controls the volume of playback during recording. However, it is only available when
you use WAVE mode to monitor playback.

Use the  button to the right of the “All channels” button to indicate whether any combination of channels can
be mixed during playback.

• When the button looks like , mixed mode is switched off. This means the program can play only one
channel at a time or all channels together.

• When the button looks like , mixed mode is switched on. This means the program can play any
combination of channels you choose below.

Indication of active channels

To indicate what channels are played back, the buttons that turn them on and off are different colors.

A small image appears to the far right  of a switched-on channel to indicate it is active. In the example below,
channels 1, 2, 3 and 4 are active:

2.8 Using a PA System During a Recording

A PA System lets you play a recording to any audio device attached to your PC. Liberty Court Recorder can play
back sound using a PA System in both WAVE and ASIO modes. 

To set options for your PA System, use “Options - Playback”. When the PA System is turned on in your options,
the main Liberty Court Recorder window includes the following:

You can show/hide these options from the View menu.

Clearing the “Enable software playback” checkbox allows you to mute and free up the output channel so that
you can use Liberty Court Player to play back a file which is not the current file being recorded. 

The slider in this section controls the volume of playback during recording. It is available only when you are
using WAVE mode to monitor playback. The Volume control for ASIO mode depends upon the device driver and
cannot be changed in Liberty Court Recorder.

You can select the channels for playback as it is monitored in a PA System. Use the  button to the right of the
“All channels” button to indicate whether any combination of channels can be mixed during playback.
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• When the button looks like , mixed mode is switched off. This means the program can play only one
channel at a time or all channels together.

• When the button looks like , mixed mode is switched on. This means the program can play any
combination of channels you choose below.

2.9 Broadcasting a Recording

The Broadcast feature allows a recording to be broadcast, or streamed, in real time. To set options for
broadcasting, use “Options - Broadcast”.

A recording can be pushed to a server, such as a Microsoft Media Server (MMS), where it would be available to
multiple users to view in real time. This feature can be used internally to allow court supervisors to monitor
court operations, or it can be used externally to allow the public to listen and watch the proceedings in
real-time. 

To review the streamed data, a user browses to the site using the appropriate MMS link and then clicks the link
to launch Windows Media Player. 

A recording can also be pulled from the recorder. This allows a user to access the stream by browsing to the
address of the recording machine. This would only be used for internal or supervisory access and not over the
Internet. 

Broadcasting can automatically be started when Liberty Court Recorder starts. Alternatively, as long as the
broadcast feature has been enabled, you can start broadcasting by doing one of the following:

• From the Audio menu, click Broadcast.

• Start a recording.

The  icon indicates that broadcasting is active. 

2.10 Playback of a Recording

To play back the current audio recording using Liberty Court Recorder, use “Tools - Playback Window”.

The following dialog appears:
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This dialog provides most of the same functions for playing recorded files as Liberty Court Player has. You can
listen to audio that has been recorded, watch video, and work with bookmarks.

The file you are recording is loaded automatically. If you want to listen to another file, you will need to play it
using Liberty Court Player.

2.11 Time Keeping

During recording, Liberty Court Recorder automatically creates the following bookmarks:

• Event-based bookmarks for these events: Start Recording, Pause, Resume, Stop Recording. The names of
these bookmarks include the date and time in local time and a short name for the event. 

• Time-keeping bookmarks that allow you to easily jump to different time points within a file. These bookmarks
do not appear in the list of bookmarks.

You can show or hide auto-bookmarks from the list of bookmarks that appears in the Bookmarks window.
From the Bookmarks window in Liberty Court Recorder or Liberty Court Player, use “View - Show Auto-
bookmarks” to show or hide auto-bookmarks.

A list of bookmarks, including some auto-bookmarks, appears below:



Liberty Court Recording System50

Copyright (C) 2004-2011 High Criteria, Inc.

2.12 Synchronization with an Outside Clock

This  feature  allows  Liberty  Court  Recorder  to  synchronize  the  time  on  your  PC  with  a  digital  clock.
Synchronization can be done in either direction. The current system time and date on your  PC can be sent to a
digital clock or you can use the time and date from a digital  clock to set these parameters on your  PC (Digital
Display Systems only).  

Synchronization between your PC and a digital clock occurs each minute.

When the synchronization process is performed, the following icon appears in  the  right-bottom corner  of  the
“Status” area in main window:

If an error occurs, the following icon appears, and detailed information about the error  appears in  the “Options
- Clock” dialog.

.

2.13 Mirroring Files to Disk

You can automatically mirror a recorded file to a location on your local machine, to a network location if you
have sufficient user rights to write to that location, or to a CD. Mirroring takes place automatically when
recording. You set mirroring options using “View - Options - Mirroring”.
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See also "Writing to Compact Discs".

Mirroring During Recording
If  “During recording” is selected, mirroring of  the  file  starts  when  the  recording  starts.  During  recording,  the
following icon appears in the top-right corner of the “Status” area in the main window:

When you stop a recording that is being mirrored to CD, the following button appears in the top-right corner of
the "Status" area in the main window. This allows you to close the current file and eject the CD. 

Hint: On some systems, the CD/DVD hardware eject button may not work or may not work consistently.

Therefore, it is recommended you click  to eject the CD tray. 

Using Liberty Court Player, you can play back a file as it is being mirrored. For more information, see "Using
Online Playback".

If an error occurs when recording with mirroring, the following icon appears, and detailed information about the
error appears in the “Options - Mirroring” dialog.

If  the connection has been lost and you stop recording,  a progress bar  appears at the bottom of  the  primary
window for about 10 seconds and you can then retry or cancel the mirroring process.

Mirroring After Recording Stops
If  “After  recording  stops”  is  selected,  the  mirroring  starts  each  time  you  stop  the  recording.  A  progress  bar
appears at the “Status” area of the main window and you have the option to cancel the mirroring process.

Mirroring to a Network Disk
When mirroring to a network  disk,  Liberty  Court  Recorder  waits  for  any  network  connection  problems  to  be
resolved. When you are using mirroring during recording, the following icon appears if a connection cannot be
established:

Completing the Mirroring Process 
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By default, if a file was not mirrored successfully, Liberty Court Recorder will try to complete the mirroring
process in the background. You can change this behavior using the "Mirroring" configuration option.

Displaying the Status of Mirror Operations
You can display the status of mirror operations. From the Help menu, click Status of Mirror Operations. A
sample display is shown below.

For each incomplete mirror operation, the following information appears: date it was created, location and
name of the source file, and the status: mirroring, waiting, open, or error. For any error, you can click the Details
button to display more information or you can choose Delete Operation if the error cannot be corrected. 

2.14 Writing to Compact Discs

You can use Liberty Court Recorder to mirror a recording to a compact disc in either ISO format or UDF format.
You can also use Liberty Court Player to export the audio data in a DCR file directly to an audio CD. For more
information, see "Exporting a File to an Audio CD".

ISO Format

An ISO-format CD can be created by any PC with a CD burner that is either running the Windows Vista
operating system or the Windows XP operating system. Liberty Court Recorder uses the Image Mastering API
from Microsoft to write in ISO format. This API is included as part of Windows Vista. For Windows XP, you must
install this API separately. You can download it by searching the Internet for:
WindowsXP-KB932716-x86-ENU.exe.  

This type of CD can be read on another PC that is running any of the Windows operating systems. An
ISO-format CD can be created by Liberty Court Recorder when mirroring a recording to a CD only after the
recording has completed. 

UDF Format

Windows Vista can create a Universal Disk Format (UDF) CD. For Windows XP, third-party software (such as
Roxio Easy CD Creator or Record Now!) is required to allow the CDs to be read on other PCs. Usually, this
software can be obtained at no extra cost from the creator of the UDF-burning software.  

Choosing Which Format to Use

If you want to mirror to a CD in real time, you must use UDF format to burn the CD. ISO formatting cannot be
used if you want to mirror to CD in real time while a recording is taking place.
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Remember to use the Test button on the Mirroring dialog box to test that Liberty Court Recorder can write to the
location specified and in the format you have specified.

Using ISO Format

To enable the creation of ISO-format CDs when mirroring a recording, you must ensure the following:

1. Mirroring is enabled. On the "View - Options – Mirroring" tab, select "Enable Mirroring".

2. Mirroring will take place when a recording has stopped. On the "View - Options – Mirroring" tab, select "
After recording has stopped". 

3. On the "View - Options – Mirroring" tab, press the Advanced button, and select "Use ISO-data format". 

4. CD recording has been enabled for your CD drive. From Windows Explorer, you can right click on your CD
drive and select Properties. On the Recording tab, check that "Enable CD recording on this drive" is selected,
as shown below.



Liberty Court Recording System54

Copyright (C) 2004-2011 High Criteria, Inc.

Using UDF Format

If you enable mirroring and choose to mirror a recording to a compact disc, the CD will use UDF format by
default. Unlike mirroring to CD using ISO format, you can mirror to CD using UDF format in real time while a
recording is taking place.  

When using UDF format, Liberty Court Recorder can automatically format a blank CD to be used in the
mirroring process. This feature requires all of the following:

• Liberty Court Recorder is running on Windows Vista.

• Your system settings related to what happens when you insert a blank CD or DVD should either be set to
"Take no action", or "Use AutoPlay for all media or devices" should be disabled.

• Liberty Court Recorder is run under the Administrators or Backup Operators group account, unless the User
Account Control is turned on. If the User Account Control is turned on, you should run Liberty Court Recorder
with the "Run as administrator" function, which is located in the pop-up menu and in the shortcut for the
program by going to "Properties - Shortcut - Advanced".

To use the autoformat feature: 

• On the "View - Options – Mirroring" tab, click the Advanced button, and select the "Autoformat blank disc"
check box below.
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Formatting a CD-R disc takes approximately 20 seconds; formatting a CD-RW disc takes approximately 20
minutes.

Once the disc is formatted, Liberty Court Recorder labels the disc as dcr_date_time, where date is in YYMMDD
format, and time is in HHMM format.

2.15 Burning Files to CD/DVD

You can burn a recorded file to another media such as a CD or DVD. You can choose to copy all discs or an
individual disc.

You can initiate burning of a file manually or you can have burning take place automatically when a recording
has stopped. You set burning options using “View - Options - Burning”.

If “After recording has stopped” is selected, a prompt appears when the recording stops asking you if the
burning process should start. If “Only manual burning” is selected, the burning process starts only when you

initiate it from the "File – Burn to CD/DVD" menu or by clicking the   button in the Status panel for an open
file. 

Once you have confirmed the burning process, you can choose to burn the file to all of the discs or you can
choose a specific disc number to burn. For example, specifying 3 in the "Copy disc number" field will burn only
disc number 3.

While burning a CD/DVD, a progress bar appears in the “Status” area of the main window and you have the
option to cancel the burning process.
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2.16 Using Text Substitution

Use Text Substitution to set shortcuts for substituting text you use frequently in file notes, bookmarks, dockets,
or predefined bookmarks. For example, you could use a shortcut key combination to quickly insert a person’s
name into a bookmark. Or you could define an abbreviation such as HTA010 to automatically substitute the text
associated with Section 010 of the Highway Traffic Act into a bookmark. The text you use can have an
associated shortcut key combination or abbreviation or both.

The Text Substitution feature also supports colors in the text. If a color is used in a text substitution entry, then
the bookmark in which the substitution is used will inherit that color. This allows you to establish a standard
set of colors for different types of text substitutions. 

You can keep the Text Substitution dialog open for quick access to your shortcuts.

Text substitution shortcuts can be exported as a file and then imported to another system to allow for
standardization amongst different users.

When you select “Tools - Text Substitution” or press the  button, the following dialog appears.

Customizing the Text Substitution Window
From the View menu, you can customize the look of the Text Substitution window as follows:

• Use Choose Columns to select the columns you want displayed.

• Use Show Fields to show or hide different fields.

• Use Choose Order to choose whether the list of text-substitution shortcuts should be in alphabetical order or

allowed to be rearranged manually.

You can customize toolbar used in the Text Substitution window. For example, you can choose which buttons
appear on the toolbar and the order in which they appear. For more information, refer to “Liberty Court Recorder
Main Window”.
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Defining Text-Substitution Shortcuts
Initially, there are some predefined shortcut key combinations defined: Ctrl+F1 – Ctrl+F9. To define a
text-substitution shortcut, you can edit one of these predefined shortcuts or define a new one. When not editing

shortcuts, you can click the  button to hide/show the bottom portion of the dialog. 

To define a text-substitution shortcut from the existing list, take the following steps: 
1. From the list of text-substitution shortcuts, select the one that you want to edit.
2. In the “Enter text” field, enter the text you want to be inserted when you use a shortcut combination key or
abbreviation. 
3. If you want to use an abbreviation for this text, type the abbreviation in the “Abbreviation” field. 

Note that If you do not want to use the shortcut key combination for this text, move your cursor to the "Press key"
box and delete the shortcut key combination.

To define a new shortcut, take the following steps:

1. Do one of the following:

• Click the  button.

• From the Edit menu, click New Shortcut.

• Right-click in the list of shortcuts and click New Shortcut from the shortcut menu.

2. In the “Enter text” field, enter the text you want to be inserted when you use the shortcut key.
3. If you want to use an abbreviation for this text, type the abbreviation in the “Abbreviation” field. 
4. If you want to use a shortcut key combination for this text: 

a) Move your cursor to the "Press key" box. 
b) In the “Press key” box, press the keyboard combination you want to use as a shortcut. Note that if this

keyboard combination is used by another active application or shortcut, the combination will not work
with Liberty Court Recorder. 

The following shows a list of text-substitution shortcuts.
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Highlighting a Text-Substitution Shortcut

Text-substitution shortcuts support the use of colors. When you use text substitution in a bookmark, the
bookmark inherits the color of the text. 

To highlight a text substitution with a background color, take the following steps:

1. Click the text substitution in the list. You can use Ctrl+Click or Shift+Click to select more than one shortcut.

2. Do one of the following:

• Click the left side of the  button to highlight the selection with the current color (as displayed on the

button), or click the arrow on the  button and select the highlight color from the drop-down list. You can
choose "None" to remove a highlight.

• On the Edit menu, click Highlight with Current Color to highlight the selection with the current color, or click
Highlight with… and select the highlight color from the drop-down list. You can choose "None" to remove a
highlight.

Alternatively, you can right click in the list of text substitutions to select the item you want to highlight. From the
shortcut menu, click Highlight with Current Color to highlight the selection with the current color.

If you want to change the color being used as the current color, based on the color of a bookmark or docket in
your list, take the following steps:
1. Right-click in the list to select the item whose color you want to use. 
2. From the shortcut menu, click Update Current Color.

Moving a Text-Substitution Shortcut
The order of text-substitution shortcuts can be alphabetic or manual. If the order is set to manual (“View –
Choose Order – Manual”), you can rearrange the list of text-substitution shortcuts by moving a shortcut up or
down in the list.
To move a text-substitution shortcut, take the following steps: 
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1. In the list of text-substitution shortcuts, click on the item that you want to move. You can use Shift+Click to
select a group of consecutive shortcuts.

2. Do one of the following:

• Click the  button to move the selection up in the list, or click the  button to move the selection down in
the list.

• On the Edit menu, click Move Up to move the selection up in the list, or click Move Down to move the selection
down in the list.

Deleting a Text-substitution Shortcut
To delete a text-substitution shortcut, take the following steps: 
1. In the list of text-substitution shortcuts, click on the item that you want to delete. You can use Ctrl+Click or
Shift+Click to select more than one shortcut.

2. Click the  button, or from the Edit menu, click Delete Shortcut.
3. Reply to the confirmation prompt.

Alternatively, you can right click on the item you want to delete and click Delete Shortcut from the shortcut
menu.

Using the Edit List Button

You can use the  (Edit List) button to minimize the Text Substitution window, and display only the text,
abbreviations, and shortcut key combinations, as shown below. This is useful when all text-substitution

shortcuts have been entered and you want to work with them during a recording. You can click , or from the
View menu, click Edit List to toggle the display.

Inserting Text using a Text-substitution Shortcut

You can use text substitution in the text fields for bookmarks, dockets, predefined bookmarks, and file notes.
To insert text at the location of your cursor, you can use a shortcut key combination, an abbreviation, or both,
depending on how you have defined the shortcut.

To insert text using a shortcut key combination, you can simply press the keyboard shortcut.
To insert text using an abbreviation, you can type the full abbreviation or display a pop-up window from which
you can select the corresponding text. 

· If the “Insert - Show Pop-up Window when using Ctrl+Space” option is not set, press Ctrl+Space, type
the full abbreviation, and press Enter.

· If the “Insert - Show Pop-up Window when using Ctrl+Space” option is set, you do not have to type the
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full abbreviation. For example, if you want to use the text associated with the abbreviation HTA010, you can
type HTA and press Ctrl+Space. A list of all text-substitution shortcuts appears, with the first possible
match highlighted. You can scroll through the list, select the text you want to use, and then double-click to
insert it. 

If the Text Substitution dialog is open, you can also use any of these methods to insert text using your
text-substitution shortcuts:

• Click the button in the first column for the shortcut.

• Double-click the entry in the list.

• Right-click the shortcut in the list, and click Insert Text from the menu.

• Highlight the shortcut in the list, and either click the   button, press Enter, or from the Insert menu, click
Insert Text.

Exporting and Importing Text Substitution Shortcuts
You may want to standardize the text substitution shortcuts amongst different users. You can export the
shortcuts as a file and then import that file to another system.

To export all of your text substitution shortcuts, take the following steps:
1. From the Text Substitution window, click Tools, and then Export Shortcuts.
2. Specify the location for the exported file.

To import text substitution shortcuts, take the following steps:
1. From the Text Substitution window, click Tools, and then Import Shortcuts.
2. Specify the location for the file containing the text substitution shortcuts.

2.17 Using a Touch Screen View

Instead of using Liberty Court Recorder's standard view, or interface, you can use a Touch Screen view. You
can choose to use the Touch Screen Full View or the Touch Screen Control View, and switch between the
different types of views as required.

When Liberty Court Recorder starts, it can automatically present one of the Touch Screen views. This is based
on your "Options - Touch View" settings.

To display a Touch Screen view from the Standard view, use “View - Touch Screen Full View”, “View - Touch
Screen Control View”, or press the hot-key combination you defined in your "Touch View" settings.

Touch Screen Full View
The following is an example of the Touch Screen Full View. This is similar to the standard view, however, you
can click on the “Keyboard” toolbar icon to invoke the Microsoft on-screen keyboard and use this to type in your
information.



Using Liberty Court Recorder 61

Copyright (C) 2004-2011 High Criteria, Inc.

Touch Screen Control View
The following is an example of the Touch Screen Control View. This is useful when all you want to do is to
quickly start recording and you do not need to add bookmarks or view video.
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Switching Views
To close a Touch Screen view and return to the Standard view or the other Touch Screen view, press the hot-
key combination you defined in your "Touch View" settings.

2.18 Using the Assistive View

A special view is available in both Liberty Court Recorder and Liberty Court Player to meet the requirements for
compliance with Section 508 of the Rehabilitation Act. 

To activate or deactivate this view, take the following steps:
1. Close any open recording files and predefined bookmark files.
2. From the View menu, click Assistive View.
3. Restart the program. 

2.19 Using the Command Line

Liberty Court Recorder can be run from the command line. For example, you can use your system scheduler to
start recording by specifying the location of the Liberty Court Recorder executable and passing it some
parameters.

The syntax to run Liberty Court Recorder from the command line is:

Lcourtre.exe [Filename] [-newfile] [-Record] [-Duration=[hh][:mm]] [-Minimize] [-Close] 

The parameters are explained below:
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[Filename] – specifies the name of a file you want Liberty Court Recorder to open. Include the full path to the
file. If the path contains spaces, enclose it in double quotes. The Filename parameter is not required if you
want to record to a new file. 

[-newfile] – create a new file. You can abbreviate this parameter as [-n].

[-Record] – indicates you want to start recording. If you specify an existing file name, the recording appends to
the existing file. Otherwise, Liberty Court Recorder creates this file using the rules you've specified for file
naming, and begins recording to this file. You can abbreviate this parameter as [-r].

[-Duration] – identifies the length of the recording in hours (hh) and minutes (mm). The recording stops after
the duration specified. You can abbreviate this parameter as [-d].

[-Minimize] – indicates the program should run in minimized mode. You can abbreviate this parameter as [-m].

[-Close] – indicates the program should close when recording has finished. You can abbreviate this parameter
as [-c].

Example

The following example creates a new file (based on your file naming rules), records data to that file for 1
minute, and then closes the Liberty Court Recorder program. 

"C:\Program Files\HighCriteria\LibertyCourtRecorder\Lcourtre.exe" -Record -Duration=00:01 -Close

2.20 Keyboard shortcuts

Use the shortcut keys for quick access to common commands.

You can use the following shortcut keys in the Main window:

Description Shortcut Key Button Menu

Create a new recording file Ctrl + N File –  New

Open an existing recording file Ctrl + O File – Open

Start recording Ctrl + R Audio – Record

Pause / continue Ctrl + U Audio – Pause

Stop recording Ctrl + T Audio – Stop

Enable confidence monitoring Ctrl + P Audio – Confidence Monitoring

Play all channels of confidence monitoring Ctrl + 0 Audio –  Playing All Channels

(monitoring)

Play a specific channel of confidence

monitoring

Ctrl + (1-8) Audio – Playing Channel (n)

(monitoring)

Change configuration options Alt + F7 View – Options

Show or hide the Bookmarks window Alt + F2 View – Bookmarks

Switch to the Thin View Alt + F5 View – Thin View

Switch to the Touch Screen Full View Ctrl + Alt + F View – Touch Screen Full

View

Switch to the Touch Screen Control View Ctrl + Alt + C View – Touch Screen Control

View

Switch to the Standard View Ctrl + Alt + S

You can use the following shortcut keys in the Bookmarks window:
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Description Shortcut Key Button Menu

Create a new bookmark F2 Edit – New Bookmark

Create a new docket Ctrl + F2 Edit – New Docket

Find text in bookmarks Ctrl + Shift + F Edit – Find

You can use the following shortcut keys in the Playback window:

Description Shortcut Key Button Menu

Play Ctrl + P Playback – Play

Stop Ctrl + T Playback – Stop

Rewind to the beginning Ctrl + H Playback – Go To – Home

Left (one step) Ctrl + F Playback – Go To – Left

Right (one step) Ctrl + G Playback – Go To – Right

Decrease the playback speed Ctrl + Shift + D Playback – Speed Play –

Decrease 

Restore the normal speed Ctrl + Shift + N x1 Playback – Speed Play –

Normal 

Increase the playback speed Ctrl + Shift + I Playback – Speed Play –

Increase 

Play all channels Ctrl + 0 Playback – Playing All

Channels

Play a specific channel Ctrl + (1-8) Playback – Playing Channel

(n)

Create a new bookmark F2 Bookmarks – New Bookmark

Find text in bookmarks Ctrl + Shift + F Bookmarks – Find

You can use the following shortcut keys in the Predefined Bookmarks window:

Description Shortcut Key Button Menu

Create a new file of predefined bookmarks Ctrl + N File – New

Open an existing file of predefined

bookmarks

Ctrl + O File – Open

Create a new bookmark F2 Edit – New Bookmark

Create a new docket Ctrl + F2 Edit – New Docket

Undo last operation Ctrl + Z Edit - Undo

Redo last operation Ctrl + Y Edit - Redo

Move a bookmark or docket up in the list Alt + Up arrow Edit – Move Up

Move a bookmark or docket down in the list Alt + Down arrow Edit – Move Down 

Restore the last-used predefined bookmark

and mark it as not used

Ctrl + Alt + Z Action – Restore Last-used

Bookmark 

Refresh the list of predefined bookmarks F5 View – Refresh

You can use the following shortcut keys in the Text Substitution window:
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Description Shortcut Key Button Menu

Create a text-substitution shortcut F2 Edit – New Shortcut

Move a text-substitution shortcut up in the

list

Alt + Up arrow Edit – Move Up

Move a text-substitution shortcut down in

the list

Alt + Down arrow Edit – Move Down 

Refresh the list of text-substitution shortcuts F5 View – Refresh

3 Using Liberty Court Player

3.1 Starting Liberty Court Player

To start Liberty Court Player:
• From the Windows Start menu, choose “Programs” – “Liberty Court Player” – “Liberty Court Player”.

3.2 Stopping Liberty Court Player

To stop Liberty Court Player:
• From the main Liberty Court Player window, either select “File - Exit”, or click the X button in the upper right-
hand corner.

3.3 Configuring Liberty Court Player

3.3.1 Configuring Liberty Court Player

To configure the system, you use the Liberty Court Player program to set configuration options.

To set configuration options: 
• From the main Liberty Court Player window, select “View - Options”. A dialog appears from which you can
access different configuration options. You can select from the following:

Dialog Use this dialog to set options for

Playback Playback devices, behavior for automatic and manual pauses

Speed Altering playback speeds

StartUp Starting Liberty Court Player

Hot Keys Setting hot keys

Foot Control Using a foot control to control playback

General Folders, displaying bookmarks window, minimizing the Liberty Court Player
application, using channel names, opening files, temporary files

Security Enabling the playback of sealed sections of a recording

Bookmark Titles Specifying which docket bookmark fields to use and the names of these fields.

You can use the following buttons:

Button Function
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OK Save your changes and exit the configuration dialogs.

Cancel Cancel all of your changes that have not been saved.

Apply Save your changes and keep the current dialog open.

Restore
defaults

Restore default settings for current dialog

Each of the configuration options is described in detail in the following sections.

3.3.2 Using the Playback Dialog

Use the Playback dialog to set options for playing files. 
When you select Playback, the following dialog appears.

Wave device
Select your audio device (sound card) for playing. If the setting is “system default”, then Liberty Court Player
uses the device specified in your system audio settings (e.g. Start - Settings - Control Panel - Multimedia -
Audio).

Playback with automatic pauses
Liberty Court Player provides an automatic-pause mode for more effective transcription. When enabled, this
feature plays a recording, pauses the playback, and then resumes the playback. This play/pause/play cycle
continues for the duration of the file playback. You can use this feature to automatically pause the playback at
certain intervals to allow you to catch up in transcribing. In some cases, this can eliminate the need for a foot
pedal or the use of hot keys to control playback.
Duration of continuous playback - Specify the duration of continuous playback, in seconds.
Size of automatic pause - Specify the size of the pause, in seconds.
Size of step back after automatic pause - Specify the size of the step back, in seconds.
For example, if you set “Duration of continuous playback” to 15 seconds, “Size of pause” to 5 seconds, and
“Size of step back after pause” to 3 seconds, then a file plays for 15 seconds, pauses for 5 seconds, and then
goes back 3 seconds and starts playing from there. 

Automatically step back after manual pause
This feature automatically rewinds the recording a specified number of seconds whenever you pause
playback. This applies when using a foot pedal or when using the Pause button on Liberty Court Player’s
primary window.
Use step back - Check this box if you want to use a step back after a manual pause.
Size of step - Specify the size of the step back, in seconds.

Retain last position
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Select this option to retain the last position of the file being played when it is closed. When you start  to play the
file again, playback starts from where it left off. 

Notification when recording is stopped
You can be notified via an audible tone when playback is paused or stopped. This alerts you that the playback
of a recording was turned off. This is useful when the auto-bookmarks are not visible, such as when using the
Thin View or when Liberty Court Player is minimized. 

To generate a simple tone when playback is stopped or paused, take the following steps: 

1. Press the "Notification when recording is stopped..." button. The following dialog appears:

2. Select “Generate a simple tone during playback”. You can adjust the frequency and duration of the tone. The

volume depends on your current system settings. To select tone parameters, click on the button.
Note: This method will not work if you are playing sound through your sound card and your card does not allow
the mixing of sounds.

Advanced 
Use this button to display the “Advanced Playback Settings” dialog.
The dialog looks like this:

Mixer device
The Mixer device lets you control the volume of sound and other playback parameters. Many Wave devices have
associated Mixer devices. Normally, the default settings (i.e. Use an associated mixer device checked and
specified Mixer device) are sufficient.  Some Wave devices do not have an associated Mixer device. You should
not choose the Mixer device of other Wave devices. Liberty Court Player will not work properly if you choose an
incorrect device.
Use an associated mixer device
This box is checked if your Wave device has an associated Mixer device. The associated Mixer device appears
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in the “Mixer device” field. You can uncheck this box if using the associated Mixer device results in problems.
This box is unchecked and the “Mixer device” field is grayed out if there is no associated Mixer device. 
Mixer device - Select a mixer device only if a Wave device has incorrectly found an associated Mixer device.

Sound processing for playing all channels
Default settings are normally acceptable. Only change these settings under the advice of Technical Support.

Speech Enhancements - Use Voice Activity Detector (VAD) for AGC
This  check  box  activates/deactivates  the  noise  suppression  amplification  algorithm  called  Voice  Activity
Detector (VAD). When this function is active, the AGC algorithm reacts only to fragments that contain voice.  This
makes  the  algorithm’s  performance  more  accurate  when  processing  voice  recordings,  and  it  prevents  the
program from raising the noise level during long pauses.

3.3.3 Using the Speed Dialog

Use the Speed dialog to set options for playback speeds. You can increase the playback speed beyond its
normal speed and you can reduce the playback speed below its normal speed. Playback speeds are
controlled through the Increase and Decrease Playback Speed buttons on the main Liberty Court Player
window. Note that these buttons are only visible during playback. The amount by which the speed increases or
decreases is controlled by the settings you specify on the Speed dialog.

When you select Speed, the following dialog appears.

Preserve tone automatically during high-speed playback
When this option is selected, Liberty Court Player tries to preserve tones when playing back a recording at a
higher than normal speed. 

Retain altered playback speed
Check this box if you want to keep this altered speed setting. Otherwise, the speed value for each new
playback is reset to the normal speed (i.e.  x1). For more information, refer to “Playback with Different Speeds”
later in this document.

Step for altering playback speeds, when they are beyond the normal playback speed
This step is used to alter playback speeds in a range from 1-times to 2-times the normal speed. When the
playback speed is above normal, this step is used when you increase or decrease speed. 
For example, if the playback speed is set at normal and this step is set to .3, then the first time you press the
Increase Playback Speed button, the playback speed increases to 1.3 times the normal speed. The next time
you press the Increase Playback Speed button, the playback speed increases to 1.6 times the normal speed,
and so on. If you press the Decrease Playback Speed button while the speed is greater than normal, then the
speed decreases by .3 times the normal speed. 

Step for altering playback speeds, when they are less than the normal playback speed 
This step is used to alter playback speeds in a range from .5-times to 1-times the normal speed. When the
playback speed is below normal, this step is used when you increase or decrease speed.
For example, if the playback speed is set at normal and this step is set to .2, then the first time you press the
“Decrease Playback Speed” button, the playback speed decreases to .8 times the normal speed. The next time
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you press the “Decrease Playback Speed” button, the playback speed decreases to .6 times the normal
speed, and so on. If you press the “Increase Playback Speed” button while the speed is less than normal, then
the speed increases by .2 times the normal speed. 

3.3.4 Using the StartUp Dialog

Use the StartUp dialog to set options for the start of the Liberty Court Player application.
When you select Startup, the following dialog appears.

Minimize when program starts
Check this box to minimize the main window after the application starts. The behavior when you minimize is
based on the minimize method (Options – Minimize).

Load a file when program starts 
You can optionally select a file to be automatically loaded when Liberty Court Player starts. Choose one of the
following:
Load last-used file – load the file Liberty Court Player last played.
Load this file – locate the specific file to be loaded.
If the file no longer exists, or has been moved, this has no effect.

Action 
Select “Start playback” if you want to automatically start playback of the file specified above after the application
starts.

3.3.5 Using the Hot Keys Dialog

Use the Hot Keys dialog to set hot keys for quick access to common commands.
When you select Hot Keys, the following dialog appears.
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Enable Hot Keys
Check this box if you want to use global hot keys.

Setting Hot Keys
To change a hot key setting, take the following steps: 
1. Click on the item in the list of commands that you want to change.
2. In the “Press new key” box, press the keyboard combination you want to use as a hot key.
3. Click OK or Apply.
You can use “Clear” to disable a hot key or “Clear all” to set all hot keys to “None”.

If any of these combinations is used by another active application or shortcut, the combination will not work
with Liberty Court Player.

3.3.6 Using the Foot Control Dialog

Use the Foot Control dialog to set options for using a foot control to control playback.
When you select Foot Control, the following dialog appears.

Enable Foot Control
Check this box if you want to use a foot control.

Device
Select your foot-pedal device from the drop-down list.

Number of pedals
Select the number of foot pedals. You can use a 2 or 3-pedal device. 

Set pedal functions
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Use this button to display the “Pedal Functions” dialog. This dialog lets you assign functions for each device
pedal and enables you to control the playback of sound data.

Foot Control Wizard
In order for the foot control to work properly, you should define a mapping of events. For example, you can
automatically step forward a specified number of seconds when you press the left pedal. You use the Foot
Control Wizard to map events.

For more information on using foot controls, refer to “Using a Foot Control”.

3.3.7 Using the General Dialog

Use the General dialog to set options for default folders, displaying of the Bookmarks window, and minimizing
of the Liberty Court Player application. 
When you select General, the following dialog appears.

Default folder 
Set a default folder for opening and saving a file. Liberty Court Player can use the previously used folder as the
default (select “Last used folder”) or you can specify the default folder yourself (select “This folder” and specify
the location).
If you type in the name of a new folder then Liberty Court Player automatically creates this folder when you click
on the OK or Apply button.

Minimize to
Choose the behavior when you minimize the Liberty Court Player application. Select one of the following:
Task Bar - appears minimized in the Task Bar. This is the normal behavior.
System Tray - appears as an icon in the System Tray.
Thin View – display Liberty Court Player's Thin View. For more information, see "Using the Thin View".

Automatically show

Choose the windows you want to have displayed automatically.

File notes window - select this box if you want to have the File Notes window automatically displayed when
opening a file that contains file notes. 

Bookmarks window - select this box if you want to have the Bookmarks window automatically displayed when
opening a file that contains bookmarks. 

Video window - select this box if you want to have the Video window automatically displayed when opening a
file that contains video. 

Use channel names
Check this box if you want to display the names of channels in place of their numbers. Channel names, if used
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during the recording, will be displayed wherever channel numbers would normally appear, such as in the
display of channel levels.

Always open file in listen-only mode

Select this check box if you want to always open files in listen-only mode. This allows you to listen to a file and
display file notes and bookmarks but prevents you from making any updates. This is useful for administrators
who won't be updating files, and it prevents the file from being locked.

Note: Listen-only mode only works properly in an NTFS environment.

Advanced

Click the "Advanced" button if you want to specify a folder for temporary files. The size of a recording file can be
quite large. Because of this, the application saves recorded information in a temporary file rather than in
memory.
When you first start the Liberty Court Player application, it sets the folder for temporary files based on the
following:
• If the system environment variable TMP exists, it uses its value.
• Else, if the TEMP system environment variable exists, it uses its value.
• Otherwise, it uses the folder where the application is installed. 

3.3.8 Using the Security Dialog

Use the Security dialog to enable you to playback sealed sections of a recording.

When you select Security, the following dialog appears.

Enable security 

Select this option if you want to playback sealed sections of a recording. You can disable security by simply
clearing the Enable security check box.

If you want to specify a password, click the "Change password" button. The Specify Password dialog box
appears:

Specify Password

Complete the following fields: 

New Recording password – password that is being used by Liberty Court Recorder to seal data.

Confirm new Recording password – re-enter the recording password.

Once you specify the Recording password, then you can use Liberty Court Player to play sealed sections of a
recording that were recorded using this same password. 

If you do not specify a password and security is enabled, then you will be prompted when you try to open a
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sealed recording to either supply the correct password or skip the sealed segments.

See also "Working with Sealed Recordings".

3.3.9 Using the Bookmark Titles Dialog

Use the Bookmark Titles dialog to select which docket bookmark fields to use and to customize the titles, or
names, for these fields.

When you select Bookmark Titles, the following dialog appears.

Use the titles in the recording file – select this check box if you want to use the recording file’s bookmark titles.
Otherwise, the bookmark titles specified here will be used.
Select the fields you want to use.
You can replace a default title by typing the new title in the corresponding text field in the “Title” column. 

3.3.10 Exporting and Importing Configuration Options

You may want to set up Liberty Court Player on similar systems with the same configuration options. From one
system, you can export the configuration options as a file and then import that file to another system.

To export all of your configuration options for Liberty Court Player, take the following steps:
1. From the main window, click Tools, and then Export Configuration Options.
2. Specify the name and location for the exported file.

To import configuration options to Liberty Court Player, take the following steps:
1. If you have a recording file open, you will need to close it.
2. From the main window, click Tools, and then Import Configuration Options.
3. Specify the name and location for the file containing the configuration options you want to import.

Once the file has been imported successfully, you must restart Liberty Court Player to continue to use it.

3.4 Using Liberty Court Player

The Liberty Court Player main window consists of different parts, as shown below:
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Liberty Court Player Menus
From the main Liberty Court Player window, you can use the following menus:

Menu Use this menu to …

File Open/close a file, export data, display file properties, exit the program.

Playback Play, pause, stop, adjust the playing speed, set channels being played, use
automatic pauses, jump to a time. 

View Show/hide different options (i.e. toolbar, tooltips, recording levels, Bookmarks
window, etc.), customize the font, switch the type of view, customize the toolbars, set
configuration options.

Tools Insert symbols, activate speech enhancements, find text in files, export/import
configuration settings.

Selection Select part of a recording.

Help Display online help, activate trace facility, analyze DCR file, display program
information.

Main Toolbar
The toolbar allows you easy access to common operations. You can use the following buttons, and associated
menu items and shortcut keys on the default toolbar:

Button Description Menu Shortcut Key
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Open an existing DCR file. File – Open Ctrl + O

Export to WMV, WAV, AVI or DCR
file.

File – Export Ctrl + Shift + E

Playback with automatic
pauses.

Playback – Automatic Pauses Ctrl + Q

Jump to time position in
recording.

Playback – Jump to time

Change configuration options. View – Options Alt + F7

Show or hide the File Notes
window.

View – File Notes

Show or hide the Bookmarks
window.

View – Bookmarks Alt + F2

Show or hide the Video window. View –  Video Window

Switch to the Thin View. View – Thin View Alt + F5

Find data in files Tools – Find in Files

Status
Displays status, length of file, absolute date and time, and time positions relative to the start and end of the file.
Both the current position in a sound file (in seconds) and the time remaining in the file (in seconds) are
displayed. When Liberty Court Player can determine the time value for the current position, this time value is
displayed in the “Time” field.
You can select “File – Properties” for more information about the current file.
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Slider (below Position)
Displays the current position in a sound file. You can move the slider back and forth. 

Selection Panel
Allows you to select a part of a recording file. For more information, see "Using the Selection Panel".

Playing channels
Controls which channels are being played. You can switch between the different channel selections using your
mouse, a hot key, or your foot pedal. If you are using more than eight channels, you can use the arrows to the
right to scroll.

The  button to the right indicates whether any combination of channels can be mixed during playback. 

• When the button looks like , mixed mode is switched off. This means the program can play only one
channel at a time or all channels together.

• When the button looks like , mixed mode is switched on. This means the program can play any
combination of channels you choose.

Volume
You can use the volume slider to control the playback volume. The indicator to the left indicates the sound level.

You can use the following buttons, menus and shortcuts:

Button Description Menu Shortcut Key

Play Playback – Play Ctrl + P

Pause/continue Playback – Pause Ctrl + U

Stop Playback – Stop Ctrl + T



Using Liberty Court Player 77

Copyright (C) 2004-2011 High Criteria, Inc.

Rewind to the beginning Playback – Go To – Home Ctrl + H

Left (one step) Playback – Go To – Left Ctrl + F

Right (one step) Playback – Go To – Right Ctrl + G

Go to end Playback – Go To - End Ctrl + E

After the and  buttons is a list where you can select the step these buttons use when positioning your
recording.

Customizing the Toolbar
You can customize the different toolbars used in Liberty Court Player. For example, you can choose which
buttons appear on the toolbar and the order in which they appear.

On the View menu, click Customize Toolbar. The following dialog box appears.

To lock the toolbar to prevent it from being repositioned, select Lock toolbar.

To show/hide the toolbar, select/clear the Visible check box.

To add a toolbar button, select a button from the list of Available toolbar buttons, and then click Add.
Alternatively, you can drag-and-drop a button from one list to the other.

To remove a toolbar button, select a button from the list of Current toolbar buttons, and then click Remove.
Alternatively, you can drag-and-drop a button from one list to the other. 

To change the position of buttons on the toolbar, select a button from the list of Current toolbar buttons, and
then click Move Up or Move Down. 

To restore the toolbar buttons to their default settings, click Restore default.

You can also customize the toolbar by right-clicking the toolbar, and then clicking Customize.
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3.5 Using the Selection Panel

The Selection panel in Liberty Court Player lets you select a part of a recording. The main use of this feature is
to allow you to export part of a file. 

An example of the Selection Panel is shown below:

Selection Panel Buttons

You can use the following buttons on the Selection panel and the corresponding items on the Selection menu:

Button Description Selection Menu Shortcut Key

Set the left selection boundary to the current
slider position.

Set Beginning of
Selection

Ctrl + Shift + P

Move the current position of the slider to the
left selection boundary.

Go to Beginning of
Selection

Clear the selection. Clear Selection

Move the current position of the slider to the
right selection boundary.

Go to End of
Selection

Set the right selection boundary to the current
slider position.

Set End of Selection Ctrl + Shift + T

Position the selection boundaries. The
selection boundary moves 1 second left and
right. The main slider’s position does not
change. The left set of buttons is for
positioning the beginning of the selection;
the right set of buttons is for positioning the
end of the selection.

Stop playing at the next selection boundary. Stop Playing at
Selection Boundary

Below the buttons, the following information appears when you make a selection:
• Absolute and relative times of the beginning of the selection.
• Size of the selection, in units of time.
• Absolute and relative times of the end of the selection.

You can show or hide the Selection panel. From the Selection menu, click Show Selection Panel.

3.6 Using the Thin View

Liberty Court Recorder and Liberty Court Player each have a "Thin View" to reduce the information in their main
windows. This mode frees up screen space and allows more room for you to work with other applications on
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your computer. 

Note: The Thin View always works in the “Always On Top” mode.

Displaying the Thin View

To display the Thin View, click the  button on the main toolbar or select “View – Thin View”.

Moving the Thin View
To move the Thin View, click in the window area outside of any button, and drag it to the desired location on
your screen.

Liberty Court Recorder
When you are recording, you can switch to the "Thin View", where only the channel recording levels are
displayed. You can also have the "Thin View" automatically displayed when Liberty Court Recorder is
minimized. The following is an example of the Thin View for Liberty Court Recorder:

Liberty Court Player

The “Thin View” reduces the main Liberty Court Player window to a single bar with a minimum set of controls. 
The following is an example of the Thin View for Liberty Court Player:

The Thin View consists of the following elements:

Element Description

Liberty Court Player icon

Open file

Play

Change playback speed (visible only during playback)

Pause/continue

Stop

Rewind to beginning

Left (one step)

Current position in sound file

Right (one step)

Select channels to play
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Restore main window

Close application

Current position indicator
The indicator of the current position has the following display modes.

  - shows the absolute time (hh:mn:ss AM or PM) of the current position.

  - shows time (hh:mn:ss) from the beginning of the file to the current position.

  - shows time (-hh:mn:ss) from the current position to the end of the file.

To switch modes, click anywhere in the indicator area.

3.7 Playback

3.7.1 Playing a Sound File

Before you Begin Playing
Set your playing device and other parameters, if they have not been set. Select “View – Options” and select the
“Playback” dialog.

If you want to view video during playback, select "View – Video", or press the  button on the main toolbar.
The Video window appears. The window remains black until there is some video to display.

Starting the Playback

To play a sound file, open the file to be played, and then click on the  button or select “Playback – Play”.
The application starts playing the file either from the current position or from the beginning if the current
position is set to the end of the file.

Viewing Video During Playback

If a sound file contains video, you can select "View – Video" to display the recorded video in a separate
window. The status bar shows the current frame size and the size of the video area. From the View menu, you
can show/hide the status bar, adjust the quality of the video, zoom in and out, and adjust the video size to fit in
the window.

Pausing the Playback

To interrupt the playing of a sound file, click on the  button or select “Playback – Pause”. To resume a

paused playback, click on the  button or select “Playback – Pause”.

Moving Within a File

To move forward or backward in a sound file, you can use the slider or the  buttons. You can also move

right or left with a fixed step using the  and  buttons, or by using the corresponding menu items or
shortcuts. 

Changing the Speed of Playback
You can change speed of playback. It can be useful for fast searches or for more effective transcription. For
more information about changing the speed, refer to “Playback with Different Speeds”.

Step Back after Manual Pause
You can use a step back after a manual pause. This is equivalent to the operations: Stop and Move left one
step. To set step-back parameters, select “View – Options” and select the “Playback” dialog.

Automatic Pauses
This mode can be useful for more effective transcription. For more information about playback with automatic
pauses, refer to “Automatic Pauses”.
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Using a Foot Control for Controlling Playback
You can control playback using a foot control. This is especially useful, for example, when transcribing sound
data into a text document. You can continue to type without interruption. For more information about using a foot
pedal, refer to “Using a Foot Control”.

Using Speech Enhancements
Before playing a file or during playback, you can suppress the level of noise and adjust the tone. Select "Tools
– Speech Enhancements". For more information, refer to "Adjusting the Tone" and "Suppressing Noise".

Stopping Playback

To stop playing, click on the button or select “Audio – Stop“.

3.7.2 Using Online Playback

You can use online playback in Liberty Court Player to play a file that is currently being mirrored. This is useful
when you want to start transcribing a file while it is still being recorded.

To play back a file in online mode, take the following steps: 

1. From the File menu on Liberty Court Player's main window, click Open.

2. Select the file currently being mirrored from the mirror directory. The file opens in online mode and you can
then use some of the playback features.

When you open a file in online mode, the bookmarks and notes are not available, and some features such as
exporting the file and finding text are not available. 

Once a sufficient amount of data has been mirrored, the slider will be enabled, allowing you to navigate within
the file. 

3.7.3 Automatic Pauses

You can use the “automatic pauses” mode for controlling playback. This is especially useful, for example,
when transcribing sound data into a text document. You can continue to type without interruption.

Before you Begin Playing
Set autopause parameters, if they have not been set. Select “View – Options”, select “Playback”, and choose
your “Playback with automatic pauses” settings. 

Starting Playback
After setting your autopause parameters, you can start the playback and indicate that you want automatic

pauses. Click the  button on the main toolbar, or select “Playback – Automatic Pauses” then click on the

 button.

Changing the Autopause Parameters During Playback
You can change parameters during playback using the “Autopause parameters” dialog. 
1. Select “Playback – Autopause Parameters” or use the Ctrl+Alt+Q hot key to launch the following dialog.
This dialog shows the current settings and allows you to change any of these values. The “Last value” column
shows the previous values you used.
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2. Choose your settings for each of the following:

 - Specify the duration of continuous playback, in seconds.

 - Specify the size of the pause, in seconds.

 - Specify the size of step back, in seconds.
You can also click on “Enable automatic pauses” to enable/disable automatic pauses during playback. 
3. Click OK.

3.7.4 Playback with Different Speeds

You can change the playback speed. This is useful for quick searches and for more effective transcription.

To change the playback speed of a sound file, use the  buttons, which are visible during playback (

). To increase the speed, click on the  button, or from the “Playback - Speed Play” menu, select “

Increase”. To decrease the speed, click on the  button, or from the “Playback - Speed Play” menu, select “
Decrease”. To restore the normal speed, click on the “x1” button, or from the “Playback - Speed Play” menu,
select “Normal”. 

The speed can be changed in a range from 0.5 times up to 3 times the normal speed. You can set the step
used to alter the speed using the “View - Options – Playback” dialog.

For quick access to these functions you can use global hot keys. For more information about global hot keys,
refer to “Using the Hot Keys Dialog”.

Playback usually starts with normal speed. However, you can use the “Retain altered playback speed” option,
in the “View - Options – Playback” dialog, to retain a speed for the next play. Note that the value of the last
speed works only within the same session of Liberty Court Player. 

3.7.5 Using Automatic Gain Control

Liberty Court Player can use Automatic Gain Control (AGC) to control the sound level of speech recording
during playback. By default, this feature is turned on.

To use Automatic Gain Control, take the following steps:

1. From the Liberty Court Player main window, select "Tools – Speech Enhancements". The following dialog
appears.
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2. Select the "Use Automatic Gain Control (AGC)" check box.

3.7.6 Suppressing Noise

You can enhance the quality of reproduced sound by suppressing unwanted noise in a recording. By default,
this option is turned on.

To suppress noise in a recording, take the following steps:

1. From the Liberty Court Player main window, select "Tools – Speech Enhancements". The following dialog
appears.

2. Select the "Use noise suppression" check box.

3. Move the slider to indicate the level of reduction. Note that it takes 1-2 seconds before the reduction takes
place.

The recommended value is 80%. Normally, noise is suppressed in the mixed result as opposed to
suppressing noise for each channel individually. If this does not have the desired result, you can change this
setting on the Advanced Playback Settings dialog.

3.7.7 Adjusting the Tone

To adjust the tone of a recording, take the following steps:

1. From the Liberty Court Player main window, select "Tools – Speech Enhancements". The following dialog
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appears.

2. Select the "Use tone control" check box. 

3. Move the slider to the left for more bass; move the slider to the right for more treble. The center position
means the file is played back with no change in tone. Note that it takes 1-2 seconds before the change takes
place.

3.7.8 Playing Back Channels

You can control which channels are being played back. This allows you to listen to all channels
simultaneously, listen to a particular channel, or listen to any combination of channels.

Selecting Channels
Select channels from the main menu, or use the “Playback – Playing Channels” menu. 

Selecting channels depends on the mixed mode that has been set. 
To choose this mode, use the button to the right of the channel number buttons or select “Audio – Playing
Channels - Enable Mixed Mode”. 

• When the button looks like , mixed mode is switched off. This means the program can play only one
channel at a time or all channels together.

• When the button looks like , mixed mode is switched on. This means the program can play any
combination of channels you choose.

You can select a channel using your mouse or a hot key.
 When mixed mode is off:
• Selecting a channel causes only that channel to be selected. 
When mixed mode is on:
• Selecting a channel causes that channel to be selected in addition to the channels already selected.

You can also use a foot pedal to tab through the different channel selections. The behavior is the same
regardless of the mixed mode. Only one channel is selected at a time.

Displaying recording level for each channel

When Liberty Court Player plays a sound file, the composite recording level is displayed on the right-hand side

of the dialog. In addition, the sound level of each channel appears, as shown below. The  icon shows you
which channels are active. 
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Changing the recording levels for individual channels
You can adjust the levels for each channel individually by using the sliders to the right of the channel level
indicators, as shown below. 

The default level for each channel is 100% (i.e. the level is not changed). For this default level, the slider is in
the center position. You can adjust the level from 25% to 400%. To restore the default level for all channels to

100%, use the  button.

3.8 Foot Control

3.8.1 Using a Foot Control

You can control playback using a foot control. This is especially useful, for example, when transcribing sound
data into a text document as it allows you to continue typing without interruption.

Liberty Court Player supports the Infinity Foot Control connected to a USB port. 

After connecting the foot control, you must adjust settings in the “Options – Foot Control” dialog and run the
Foot Control Wizard. The Foot Control Wizard sets the mapping of events for use with Liberty Court Player.

Using the “Pedal Functions” dialog you can associate a function with each foot pedal. 

Instead using a foot control for transcription, you can also use hot keys. For more information, refer to “Using
the Hot Keys Dialog”.

3.8.2 Associating Functions to Foot Pedals

The “Pedal Functions” dialog looks like this:
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This dialog lets you assign functions for each device pedal and enables you to control the playback of sound
data.

Step back by x sec. - move backward from current position each time the pedal is pressed. You can adjust the
size of the step from 1 to 999 seconds.
Rewind with n times normal speed - rewind from the current position while the pedal is pressed. You can
adjust the speed from 0.5 times to 3 times the normal speed.
Play while pressed / Stop when released - play while the pedal is pressed; stop when the pedal is released.
Play / Step back by x sec. when released - play while the pedal is pressed; stop when the pedal is released
and automatic move backward from current position. You can adjust the size of the step from 1 to 999
seconds.
Step forward by x sec. - move forward from current position each time the pedal is pressed. You can adjust
the step from 1 to 999 seconds.
Forward with n times normal speed - fast forward from the current position while the pedal is pressed. You
can adjust the speed from 0.5 times to 3 times the normal speed. When using this option it may be useful to
automatically step back a specified number of seconds when you release the foot pedal. You can specify the
number of seconds in the "and step back by x sec. when released" field.
Switch between the playing channels - tab through the channel selections: All channels, Channel 1, Channel
2, and so on.

3.8.3 Using the Foot Control Wizard

The Foot Control Wizard helps you map events for your foot control. For more information about using a foot
control, refer to the “Using a Foot Control” section of this document.
You can run this wizard at any time by selecting “View – Options – Foot Control” and clicking on the “Foot
Control Wizard” button.

Before running the Foot Control Wizard, you should connect your foot control to your PC.
The Foot Control Wizard consists of the following pages:
• A Welcome page
• Choice of device
• Analysis and mapping of pedal movements
• Completion of Foot Pedal Wizard.
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Analysis and mapping of pedal movements
The page looks like this:

To analyze and map the pedal movements, take the following steps:
1. Click the “Start” button to start the Foot Control Wizard.
2. Press and release the pedals of your device, as follows:

• For a 2-pedal control: press the left pedal, release the left pedal, press the right pedal, release the right
pedal.
• For a 3-pedal control: press the left pedal, release the left pedal, press the middle pedal, release the
middle pedal, press the right pedal, release the right pedal.

3. Click the “Stop” button to stop the Foot Control Wizard, if it has not stopped automatically after releasing the
last pedal. A message appears indicating whether or not the wizard was able to successfully set map the
pedal movements.
If the red indicators do not light up while you press the pedals, the Foot Pedal Wizard cannot map the pedal
movements. This can be caused by the following:
• Your device is switched off, it is not connected, or it does not work properly.
• You have a non-standard device and the Foot Pedal Wizard was not able to detect the pedal movements.

3.9 Bookmarks

3.9.1 Working with Bookmarks

Bookmarks allow you to:
• navigate quickly in a sound file
• store notes at chosen positions in a sound file.
• work with file attachments, such as evidence documents.
• store time points in a recording by using auto-bookmarks.
• distinguish cases by using a special bookmark called a docket.
• standardize or classify bookmarks based on color (e.g. use different colored bookmarks to differentiate child
witnesses, sensitive information, etc.)
• seal all of a recording or parts of a recording.
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Bookmarks are automatically created during a recording at regular time intervals and for certain events, such
as when a recording starts. The notation for each bookmark consists of the date (mm/dd/yy), the time of
occurrence (hh:mn:ss), and the short name of the event. For example:
• 10/24/2004 11:20:23 PM - Start Recording 

In addition to automatic bookmarks created during a recording, you can manually create bookmarks using
Liberty Court Recorder and Liberty Court Player. To save time, you can use either Liberty Court Recorder or
Liberty Definition Editor to predefine bookmarks before a recording, and then insert them as you need them
during your recording. You can also use text-substitution shortcuts to automatically insert predefined text into
these bookmarks with a keyboard shortcut or abbreviation.

Optionally, you can exclude different parts of a file when exporting a .dcr file to another file or when exporting
bookmarks to a text file.

Displaying the Bookmarks Window

To display the Bookmarks window, click the  button on the main toolbar, or select “View – Bookmarks”. The
following is an example of the Bookmarks window in Liberty Court Player:

The bookmarks window consists of a list of bookmarks, sorted by the position within the sound file. Below this
are the fields you can edit. 

Customizing the Bookmarks Window

You can customize what information appears on the Bookmarks window and change its appearance. For
example, you can choose which columns of information to display and change the order in which the columns
are displayed across your screen. See also "Customizing the Column Settings".

You can also use the following options from the View menu:

View Menu Option Function

Toolbar Show/hide the Bookmarks toolbar.
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Show Auto-bookmarks Show/hide automatically created bookmarks.

Show Icon Show/hide the icon in the first column.

Show Date Show/hide the date in the Time column.

Choose Columns Select the columns you want displayed and the order in which you
want them to appear.

Show Fields Show/hide different fields in the display for each bookmark

You can also use "View – Font" from the main Liberty Court Recorder window to change the font used for
headings and text fields in the Bookmarks window.

Toolbar
The toolbar allows you easy access to common operations. You can use the following buttons, and associated
menu items and shortcut keys on the default toolbar:

Button Description Recorder's Bookmarks
Menu

Player's Bookmarks
Menu

New bookmark Edit – New Bookmark Edit – New Bookmark

New docket Edit – New Docket Edit – New Docket

New attachment Edit – Attach File -

Delete bookmarks Edit – Delete Edit – Delete

Begin seal Edit – Begin Seal Edit – Begin Seal

End seal Edit – End Seal Edit – End Seal

Change position or length of
bookmark

- Edit – Reposition

Highlight a bookmark or
docket

Edit – Highlight with … Edit – Highlight with …

Find text in file notes Edit – Find Edit – Find

Scroll through list of
bookmarks as position in
sound file changes

- Position – Auto Scroll

You can customize toolbar used in the Bookmarks window. For example, you can choose which buttons
appear on the toolbar and the order in which they appear. For more information, refer to “Using Liberty Court
Player”.

Customizing the Column Settings

You can customize the look of the Bookmarks window by selecting the columns of information you want
displayed and the order in which they appear across your screen.

Selecting the Columns to Display

To select the columns you want displayed, do one of the following: 

• Right-click any column title. On the menu that appears, click the name of the column to add it or remove it
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from the list of columns to be displayed.

• Right-click any column title, and click More. Or, on the View menu, click Choose Columns. The Column
Settings dialog box appears, as shown below. Select the columns you want displayed. You can either click the
check box or click the column title to highlight it and click Show.

Changing the Order of the Columns

To change the order in which the columns are displayed, you can click the column you want to move, hold your
mouse down, and drag the column to its new position. This is similar to moving columns in Windows
Explorer. 

Alternatively, you can take the following steps to change the column order:

1. Do one of the following: 

• Right-click any column title, and select More.

• On the View menu, click Choose Columns. 

The Column Settings dialog box appears. The names of the columns from top to bottom reflect the order in
which the columns appear from left to right on your screen.
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2. Click the name of the column you want to move to highlight it.

3. Use the Move Up or Move Down button to change the order in which the name of the column appears.

3.9.2 Editing Bookmarks

Creating a new bookmark
If you want to mark a point in a sound file, you can create a positional bookmark by taking the following steps:
1. Use the Slider to set the current position (Liberty Court Player only).

2. Use the F2 shortcut, click the  button on the bookmark toolbar, or from the Edit menu, select “New
Bookmark”.
3. A new bookmark appears in the list and you are placed in the first field below.
4. Type the information you want to store in the new bookmark.

Creating a sealed bookmark 

You can use sealed bookmarks to seal or protect parts of a recording. Sealed sections of a recording require a
password for them to be played.

To seal part of a recording, click the  button on the bookmark toolbar, or from the Edit menu, select "Begin
Seal". The recording will be sealed until an End Seal bookmark is encountered. To create an End Seal

bookmark, click the  button on the bookmark toolbar, or from the Edit menu, select "End Seal".

Editing bookmark notes 
You can edit the notation of a bookmark by taking the following steps:
1. Select the bookmark.
2. Click in the “Note” field.
3. Update the notation, as required.

Creating a new docket
From Liberty Court Recorder or Liberty Court Player, you can create a special bookmark called a docket. This
allows you to distinguish cases within the same file. A docket uses a predefined format.

To create a docket, take the following steps:

1. Use the Ctrl+Alt+F2 shortcut, click the  button on the bookmark toolbar, or from the Edit menu, select “New
Docket”. The following dialog appears.
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2. Complete the information as required. If you want the docket to be sealed, select Seal Docket. A password
will be required to listen to information pertaining to this docket. 

3. Press OK to add the docket to the list of bookmarks.

Editing a docket 
You can edit the information in a docket by selecting it in the list of bookmarks and updating the note.

Attaching a File

From Liberty Court Recorder, you can attach files, such as evidence documents, to a recording file. You can
open attachments, delete attachments, seal/unseal attachments, and optionally include them when exporting
recording files.

File attachments appear in lists of bookmarks, which means you can work with them just as you do any other
type of bookmark or docket. 

To attach a file, take the following steps:

1. Click the  button on the bookmark toolbar, or from the Edit menu, select Attach File. The following dialog
appears.
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2. Locate and select the file you want to attach. 

3. Optionally, add any notes in the Notes field.

4. If you want the attached file to be sealed within an unsealed section of the recording, select Seal
Attachment. Note that by default, an attachment is automatically sealed if it is inserted within a sealed section
of the recording. A password will be required to display the information in a sealed attachment. 

5. Click the Open button to add the attached file to the list of bookmarks.

Opening an Attached File

To open a file attachment in a recording: 

· Select the attachment in the list of bookmarks, and then from the Edit menu, click Open Attached File,
or click the Open button in the bottom part of the dialog box. 

The attached file will be opened in read-only mode in the corresponding program.

Sealing and Unsealing an Attached File During Playback

During playback, you can seal and unseal files attached to a recording. 

To seal an attachment:

· Select the attachment in the list of bookmarks, and then from the Bookmarks menu, click Seal
Attached File.

To unseal an attachment:

· Select the attachment in the list of bookmarks, and then from the Bookmarks menu, click Unseal
Attached File.

Highlighting a bookmark or docket

To highlight a bookmark or docket with a background color, take the following steps:
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1. Click the bookmark or docket in the list.

2. Do one of the following:

• Click the left side of the  button to highlight the selection with the current color (as displayed on the

button), or click the arrow on the  button and select the highlight color from the drop-down list. You can
choose "None" to remove a highlight.

• On the Edit menu, click Highlight with Current Color to highlight the selection with the current color, or click
Highlight with… and select the highlight color from the drop-down list. You can choose "None" to remove a
highlight.

Alternatively, you can right click in the list of bookmarks and dockets to select the item you want to highlight.
From the shortcut menu, click Highlight with Current Color to highlight the selection with the current color.

Tip: You can press Ctrl+Click or Shift+Click to select multiple items to highlight all at once.

If you want to change the color being used as the current color, based on the color of a bookmark or docket in
your list, take the following steps:
1. Right-click in the list to select the item whose color you want to use. 
2. From the shortcut menu, click Update Current Color.

Deleting a Bookmark, Docket, or Attachment

To delete a bookmark, docket, or attachment, take the following steps:

1. Click the bookmark, docket, or attachment in the list.

2. Click the button on the bookmark toolbar, or from the Edit menu, select Delete.

Repositioning a bookmark 
You can change the position of an existing positional bookmark by taking the following steps:
1. Use the Slider to set the new position.
2. Select the bookmark.

3. Click the  button on the bookmark toolbar, or from the “Edit” bookmark menu, select “Reposition”.

3.9.3 Using Predefined Bookmarks

To save time, you can define bookmarks in advance and then later insert them into your actual recordings.
These predefined bookmarks are stored in a file with a .xml extension. You can have different files containing
different bookmarks, and load each file as required, even after a recording has started.
You can predefine bookmarks using Liberty Court Recorder, Liberty Definition Editor, or Liberty Network
Monitor.  The  Liberty Definition Editorprogram allows you to predefine bookmarks on a PC on which Liberty
Court Recorder is not installed.

While working with predefined bookmarks, you can use the  button, the  button, or the corresponding
items on the Edit menu to undo and redo changes. For example, you may want to undo a delete operation or a
change to one of the fields you’ve made.

Setting Up a New File for Predefined Bookmarks

To set up a new file for predefined bookmarks, take the following steps: 

1. From the Tools menu, click Predefined Bookmarks, or press the  button on the main toolbar. The
following dialog appears:
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2. The first time this dialog appears, you need to specify the location and name of a file to store your predefined

bookmarks. Click the  button, or from the File menu, click New, to locate the directory where you want to
store your predefined bookmarks.

3. In the "File name" field, specify a name for the file. Note that Liberty Court Recorder will create this file and
add the .xml extension to the name you specify.

4. Click "Save". Liberty Court Recorder creates the file in the directory you choose, and opens it for editing.

Once you set up a file to store predefined bookmarks, you can open the file as required and do the following:

• Insert bookmarks and dockets into a recording.

• Create, edit, and delete bookmarks and dockets. 

• Customize the list of bookmarks and dockets you create by moving them up or down in the list, adding a
separator, highlighting the background color used, or by changing the column settings.

• Append the contents of another bookmark file to the file you have open.

Opening a File of Predefined Bookmarks

To open a file of predefined bookmarks, take the following steps:

1. If the Predefined Bookmarks dialog is not open, from the Tools menu, click Predefined Bookmarks, or click

the  button on the main toolbar. The "Predefined Bookmarks" dialog appears.

2. Do one of the following:

• Click the  button, and select the file you want to open.
• From the File menu, click Open, and select the file you want to open.
• From the File menu, select the file from the list of files used in the past.
•Click on the arrow button next to the File field, and use the drop-down list of past entries to locate the file you
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want to open. 

The file opens with any predefined bookmarks and dockets displayed in a list, as shown below.

Creating a New Bookmark

To create a new bookmark, take the following steps: 

1. Do one of the following: 

• Click the  button.

• On the Edit menu, click New Bookmark.

• Right click in the list of bookmarks and dockets. From the shortcut menu, click New Bookmark.

If the "Edit List" at the bottom of the screen is not visible, click the  button, or from the View menu, click Edit
List.

The following dialog appears:
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2. Fill in the fields below. Liberty Court Recorder adds the bookmark to the list of predefined bookmarks.

Creating a New Docket

To create a new docket bookmark, take the following steps:

1. Do one of the following: 

• Click the  button.

• On the Edit menu, click New Docket.

• Right click in the list of bookmarks and dockets. From the shortcut menu, click New Docket.

If the "Edit List" at the bottom of the screen is not visible, click the  button, or from the View menu, click Edit
List.

The following dialog appears:
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2. Fill in the fields below. If you want the docket to be sealed, select Seal Docket. A password will be required
to listen to information in the sealed docket. Liberty Court Recorder adds the docket bookmark to the list of
predefined bookmarks.

Deleting a Bookmark or Docket

To delete a bookmark or docket, take the following steps:

1. Click the bookmark or docket in the list.

2. Do one of the following: 

• Click the  button.

• On the Edit menu, click Delete. 

Alternatively, you can right click on the bookmark or docket to select it. From the shortcut menu, click Delete.

3. Reply to the confirmation prompt.

Tip: You can press Ctrl+Click or Shift+Click to select multiple items for deletion.

Editing a Predefined Bookmark

To edit the contents of a bookmark or docket, take the following steps:

1. Select the bookmark or docket in the list.

2. Edit the fields below. If the fields are not visible, click the  button, or from the View menu, click Edit List.

Inserting a Predefined Bookmark into a Recording

To insert a predefined bookmark into a recording, open the file containing the predefined bookmark you want to
insert, and do one of the following:
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• Click the  button in the first column for the bookmark. 

• Highlight the bookmark in the list and click the  button.

• Highlight the bookmark in the list and press Enter.

• Highlight the bookmark in the list and from the Action menu, click Insert Bookmark into Recording.

• Double-click the bookmark in the list.

Tip: You can press Ctrl+Click or Shift+Click to select multiple items for insertion.

When you insert a predefined bookmark into a recording, there may be some visual indication that the
bookmark has been used. The behavior is determined based on your "Options – Predefined Bookmarks"
settings. For example, the color of the icon in the first column may turn grey, the bookmark may be moved to the
bottom part of the list, and/or the background of the bookmark may be highlighted. 

Note that when inserting predefined bookmarks, it may be useful to minimize the "Predefined Bookmarks"

dialog by clicking the  button, or from the View menu, click Edit List. This hides the details for each
bookmark while allowing you to work with your list of predefined bookmarks, as shown below. You can press
the button again to toggle the display.

Resetting Usage Indicators

When a court case is stood down, you can reset the usage indicator for the corresponding predefined
bookmark. From the Action menu, click Restore Last-used Bookmark. This restores the last-used predefined
bookmark and marks it as not used. You can repeat the command to restore prior bookmarks.

To reset the status of all used bookmarks: from the Action menu, click Reset Usage Indicators, and reply to
the confirmation prompt.

To mark a bookmark as used without having it inserted into your current recording: from the Action menu, click
Mark Bookmark as Used. You can use this command if you mistakenly restore the last-used predefined
bookmark, or you can use this command after selecting one or more predefined bookmarks in the list.

Inserting a Separator

You can insert a blank space to separate items in your list. To insert a blank space, take the following steps:

1. Click the bookmark or docket in the list after which you want to insert the blank space.

2. On the Edit menu, click Insert Separator. A blank space appears after your selection.

Alternatively, you can right click in the list of bookmarks and dockets where you want to insert a separator. From
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the shortcut menu, click Insert Separator.

Changing the Order of Items in the List
You can sort the list of predefined bookmarks alphabetically or you can move bookmarks or dockets up or
down in the list.

From the View menu, click Choose Order, and choose whether the list of predefined bookmarks should be in
alphabetical order or allowed to be rearranged manually.

Sorting the List of Predefined Bookmarks

To sort the list of predefined bookmarks alphabetically:

· If the up and down arrows on the toolbar are not grayed out, from the View menu, click Choose Order, and
select Alphabetic.

You can click any of the column headers to sort the list alphabetically based on that column.

Moving a Bookmark or Docket

To move a bookmark or docket up or down in the list, take the following steps:

1. If the up and down arrows on the toolbar are grayed out, from the View menu, click Choose Order, and
select Manual.

2. Click the bookmark or docket in the list.
3. Do one of the following: 

• Click the  button to move the selection up in the list, or click the  button to move the selection down in
the list.

• On the Edit menu, click Move Up to move the selection up in the list, or click Move Down to move the selection
down in the list.

Tip: You can press Shift+Click to select a group of items and move them all at once.

Highlighting a Bookmark or Docket

To highlight a bookmark or docket with a background color, take the following steps:

1. Click the bookmark or docket in the list.

2. Do one of the following:

• Click the left side of the  button to highlight the selection with the current color (as displayed on the

button), or click the arrow on the  button and select the highlight color from the drop-down list. You can
choose "None" to remove a highlight.

• On the Edit menu, click Highlight with Current Color to highlight the selection with the current color, or click
Highlight with… and select the highlight color from the drop-down list. You can choose "None" to remove a
highlight.

Alternatively, you can right click in the list of bookmarks and dockets to select the item you want to highlight.
From the shortcut menu, click Highlight with Current Color to highlight the selection with the current color.

Tip: You can press Ctrl+Click or Shift+Click to select multiple items to highlight all at once.

Appending One File to Another

You can append the bookmarks and dockets from a file to the file that is currently open in the Predefinition
Bookmarks window. 

To append a file, take the following steps:

1. From the File menu, click Append. The Append dialog appears.

2. Locate the file you want to append, and click Open. An empty bookmark (separator) is inserted at the bottom
of the current file followed by all of the bookmarks and dockets from the appended file.
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Customizing the Toolbar
You can customize toolbar used in the Predefined Bookmarks window. For example, you can choose which
buttons appear on the toolbar and the order in which they appear. For more information, refer to “Liberty Court
Recorder Main Window”.

Customizing the Column Settings

You can customize the look of the Predefined Bookmarks window by selecting the columns of information you
want displayed, the order in which they appear across your screen, and the titles for the docket bookmark
fields.

Selecting the Columns to Display

To select the columns you want displayed, do one of the following: 

• Right-click any column title. On the menu that appears, click the name of the column to add it or remove it
from the list of columns to be displayed.

• Right-click any column title, and click More. Or, on the View menu, click Choose Columns. The Column
Settings dialog box appears, as shown below. Select the columns you want displayed. You can either click the
check box or click the column title to highlight it and click Show.

Changing the Order of the Columns

To change the order in which the columns are displayed, you can click the column you want to move, hold your
mouse down, and drag the column to its new position. This is similar to moving columns in Windows
Explorer. 

Alternatively, you can take the following steps to change the column order:
1. Do one of the following: 

• Right-click any column title, and select More.

• On the View menu, click Choose Columns. 

The Column Settings dialog box appears. The names of the columns from top to bottom reflect the order in
which the columns appear from left to right on your screen.
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2. Click the name of the column you want to move to highlight it.

3. Use the Move Up or Move Down button to change the order in which the name of the column appears.

Changing the Titles of the Columns

To change the titles of the columns and the names of the docket fields, from the main Liberty Court Recorder
window, use "View – Options" and select Bookmark Titles. Customize the fields as required.

Closing a File of Predefined Bookmarks

To close a file of predefined bookmarks:
• From the File menu, click Close.

3.9.4 Using Special Characters

You can use special characters and symbols that don't appear on your keyboard for the text you type in different
places, including the following: 

• Fields for bookmarks and dockets, including notes.

• Text field when using "Find in Files" to search files.

• Text field when using "Find Text in Notes" to search notes.

• Text area of the Text Substitution window.

For example, you can use international characters such as à and ë, or symbols such as ¢ and ¼. 

Inserting a Special Character

To insert a special character or symbol, take the following steps:

1. Click where you want to insert the character. 

2. Use the Symbol dialog box to insert the character. You can access this dialog from the following places:

Recorder or Player Location To access…

Liberty Court Recorder Main window On the Tools menu, click Insert Symbol.

Liberty Court Recorder Playback window On the Bookmarks menu, click Insert Symbol.
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Recorder or Player Location To access…

Liberty Court Recorder New docket dialog box Click the  button.

Liberty Court Recorder Touch Screen View Click the  button.

Liberty Court Player Main window On the Tools menu, click Insert Symbol.

The Symbol dialog box is shown below.

3. Double-click the character you want to insert. 
Alternatively, you can select the character and click Insert, use the "Shortcut key" displayed in the Symbol dialog
box, or press Alt+ the symbol code. If you click Insert and Close, the symbol will be inserted and the Symbol
dialog box closes.

Note: The "Symbol code” that appears on the Symbol dialog shows you information regarding the standard
Windows key combination for entering a character. If you know the character code for a character, you do not
need to open the Symbol dialog box. You can simply click where you want to insert the character, hold down
the Alt key, and use the numeric keys on the right side of your keyboard to type the "Symbol code". This feature
depends on your operating system. You can use this combination to insert a symbol in any text field in any
dialog and is not limited to the places listed above.

3.9.5 Working with Sealed Recordings

You can seal a recording or parts of a recording. This secures the sealed sections of the recording and these
sections can only be played (unsealed) under special circumstances. Sometimes the audio may be unsealed
permanently and become part of the regular public record. Other times, the audio may be unsealed
temporarily. 

During a recording or after a recording has been made, you can seal the recording between a Begin Seal
bookmark and an End Seal bookmark. This causes that section of the recording to be encrypted. Users with
the appropriate security can play back sealed parts of a recording.

Using Security with Liberty Court Recorder 

To enable recordings to be sealed: use "View - Options – Security" in Liberty Court Recorder, select Enable
security, and specify and confirm a recording password and override password. This allows you to use Begin
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Seal and End Seal bookmarks in a recording to secure the data between them. If you try to open a sealed
recording later then you must use the same password for full access to the entire recording.

If security was not enabled when a recording took place then you will not be able to add sealed bookmarks to
it, even if security is now enabled. 

If you try to open a file previously recorded where security was enabled, but now security has been disabled,
then you will be able to open the file, but you will only be able to play unsealed audio. You will not be able to
create or delete any sealed bookmarks. 

Using Security with Liberty Court Player 

If you want to use Liberty Court Player to play the sealed sections of a recording, you can use "View - Options –
Security" in Liberty Court Player to enable security and to specify the same recording password you specified
in Liberty Court Recorder. You will have complete access to the entire audio and all of the bookmarks that used
the same recording password to secure the file. You can export any part of the audio.

If security is enabled in Liberty Court Player, but either the password has not been specified or it does not
match the password used to encrypt the file you want to play, you will be prompted as you open a sealed
recording to either specify the correct password or to skip the sealed segments. 
If security is not enabled in Liberty Court Player then you will not receive any prompts when you open a sealed
recording. Sealed segments will be automatically skipped. This is useful on public-use PCs in the courthouse
where people should not be listening to the sealed portions of recordings.

Exporting a File with Sealed Segments
You can use Liberty Court Player with the correct recording password to export a file with sealed segments.
There are four different options available to deal with the sealed segments. 

Export with sealed segments – export the file with all sealed segments. A password is required to listen to the
sealed segments.

Export with sealed segments and a new access password – export the file keeping all sealed segments
encrypted, but access to the sealed segments will require a different access password. Specify and verify an
access password for this file. A user that wants to listen to the sealed sections must supply this same
password. 

Export and delete any sealed segments - export the file and delete all sealed segments. Automatic stop/start
bookmarks are substituted to indicate where the sealed segments were removed. This is useful when you
want a recording to be unsealed permanently and made part of the standard public record. 

Export and unseal any sealed segments – export the file with all sealed segments unsealed. The sealed
bookmarks are removed. None of the data in the file will require a password for access.

3.9.6 Jumping to Time Points in a Recording

When you open a file, there are time points at regular  intervals and also for events such as when a recording
starts or stops. Time points in a file allow you to jump to positions based on absolute time and date values.

The current time position in the file is displayed in the “Time” field in Liberty Court Player’s main window. In the
following example, the recorded file is 5:02 seconds long. The recording is positioned at 3/31/2010 12:32:33
AM, which is 1:22 seconds from the beginning of the file and it is 3:40 seconds to the end of the file. 

To jump to a time point, take the following steps:

1. In the main Liberty Court  Player window,  use “Playback - Jump to  time”  or  press   on  the  toolbar.  The
following dialog appears:
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2. In the “Date” field, select a date from the list of dates that appear  in  the file. Optionally, you can use the “Set
current position” button to fill the Date and Time fields with the current position.

3. In the “Time” field, specify the time. You can press the  button to display a list of previous time values you
have used, and select a time from the list.

4. Press the “Jump” button. 

Liberty Court Player jumps to the time/date location in the file, if it exists. Otherwise, the “Jump to nearest
position” dialog appears, from which you can choose the nearest time position (i.e. either the previous or next).

3.9.7 Finding Text in File Notes and Bookmarks

You can search for text in file notes and bookmarks within an open file in Liberty Court Recorder or Liberty
Court Player.
These programs also have a search facility you can use to find text across a number of DCR files. See "File
Search Facility" for more information.

Liberty Court Recorder and Liberty Court Player also have a search facility you can use to find text across a
number of DCR files. See "File Search Facility" for more information.

To find text in file notes or bookmarks within an open file, take the following steps:
1. Do one of the following:

· In the Bookmarks window, from the Edit menu, select Find

· In the Playback window, from the Bookmarks menu, select Find.

· Click  on the toolbar. 

The following dialog appears:
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2. In the Find what field, enter the text on which you want to search.
3. If you want to find the exact phrase you typed above, select the Find the exact phrase check box. Otherwise,
the program looks for any of the words you typed.
4. If you want to use a phonetic algorithm, select the Use a phonetic algorithm check box. The Metaphone
algorithm is used unless you have chosen the Soundex algorithm in the Advanced Find Settings dialog box
when using the file search facility. 
5. Click the Find Next button to start the search process. 

If the text is found, it becomes highlighted in the first instance found. You can then use the Find next button to
find the next instance of the text. You can use the Previous button to display the previous search result. 

3.9.8 Replacing Text in File Notes and Bookmarks

You can search and replace text in file notes and bookmarks within an open file in Liberty Court Recorder or
Liberty Court Player.

To find and replace text in file notes or bookmarks within an open file, take the following steps:
1. Do one of the following:

· In the Bookmarks window, from the Edit menu, select Replace.

· In the Playback window, from the Bookmarks menu, select Replace.

The following dialog appears:

2. In the Find what field, enter the text on which you want to search.
3. If you want to match the exact case, select Match case.
4. In the Replace with field, type the replacement text.
5. Do one of the following:

· To find the next occurrence of the text, click Find Next.

· To replace an occurrence of the text, click Replace. After you click  Replace, the program moves to the next
occurrence of the text.

3.9.9 Navigation Using Bookmarks

Bookmarks allow you to navigate quickly in a sound file.

To get to a bookmarked position in a sound file, you can do one of the following:
• Double click on the bookmark.
• Select a bookmark and from the “Position” bookmark menu, select “Go to Current”.



Using Liberty Court Player 107

Copyright (C) 2004-2011 High Criteria, Inc.

To get to the position of the previous bookmark: from the “Position” bookmark menu, select “Go to Previous”.

To get to the position of the next bookmark: from the “Position” bookmark menu, select “Go to Next”.

Special Bookmarks functions
You can use the following special bookmark functions.

Auto Scroll
When this function is activated, the cursor in the list of bookmarks automatically moves together with the
position in the sound file. For example, you can use this option to automatically see the full contents of each
bookmark while listening to a recording.

To activate this function, check the  button on the bookmark toolbar, or from the “Position” bookmark menu,
select “Auto Scroll”.

Select Closest
This feature finds the closest bookmark to the current position in a sound file. In the Bookmarks window, select
“Position - Select Closest”.

3.9.10 Private Notes in Bookmarks

The text of each bookmark you create can consist of two parts – a note and a private note. Private notes allow
you to store additional information as a separate part, and you can optionally exclude this information when
exporting bookmarks to a text file and when exporting a .dcr file (see “Exporting File Notes or Bookmarks to a
Text File”, “Exporting a File”).

You cannot edit notes in auto-bookmarks. 

You can show or hide private notes in the Bookmarks window by using “View – Show Fields - Show Private
Notes”.

3.9.11 Importing Bookmarks from a BMR File to a DCR File

With Liberty Notes and Liberty Word-Notes, you can create a bookmark file and save it as a BMR file (i.e. with a
file extension of .bmr). Using Liberty Court Player, you can import a BMR file into a DCR file that was created
with Liberty Court Recorder. 

Note: To import a BMR file into a DCR file, the DCR file must contain auto-bookmarks for time keeping 

To import a BMR file into a DCR file, take the following steps:

1. From Liberty Court Player, open the DCR file. 

2. If the Bookmarks window is not displayed, select “View – Bookmarks”.

3. From the Bookmarks window, select “File – Import from BMR file”. The following dialog appears:
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4. Select the directory containing the .bmr file. 
5. In the “File name” field, enter the name of the file or select it from the list above.

6. In the “File Notes” section, select the method for importing the file notes:

• Append  - the file note from the BMR file is added to the existing one in the DCR file.

• Overwrite - the file note in the DCR file is cleared before importing.

7. In the “Bookmarks” section, select the method for importing bookmarks:

• Insert – all bookmarks from the BMR file are added to the DCR file except when an identical bookmark
with the same note text and position already exists in the DCR file. Note that different bookmarks can have
the same position in a DCR file as long as their text is different.

• Overwrite – all bookmarks in the DCR file are deleted before the import occurs.

8. Select the destination for bookmark text:

• Notes – bookmark text is copied to the note of a bookmark.

• Private notes – bookmark text is copied to the private note of a bookmark.

9. Press “Open”.

3.9.12 Exporting File Notes or Bookmarks to a Text File

With Liberty Court Recorder and Liberty Court Player, you can export text information contained in file notes and
bookmarks to a text file. 
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To export file notes or bookmarks from a file, take the following steps:

1. Open the file in Liberty Court Recorder or Liberty Court Player.

2. If the Bookmarks window is not open, choose "View – Bookmarks" to open it.

3. From the Bookmarks window, choose “File - Export to Text File". The following dialog appears: 

3. In the “File name” field, specify the name of the file to which the bookmarks will be saved. This file will be
created automatically.

4. In the “Include data” options, select the data you want to export. "(empty)" indicates the field contains no data.

5. Press “Save”.

The following is a sample text file containing exported file notes and bookmarks:
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3.9.13 Copying File Notes or Bookmarks to the Clipboard

With Liberty Court Recorder and Liberty Court Player, you can copy text contained in file notes or bookmarks to
the Windows clipboard. 

To copy file notes or bookmarks to the clipboard, take the following steps:

1. Open the file in Liberty Court Recorder or Liberty Court Player.

2. If the Bookmarks window is not open, choose "View – Bookmarks" to open it.

3. From the Bookmarks window, choose “File - Copy to Clipboard”. The following dialog appears: 

4. In the “Include data” options, select the data you want to copy. "(empty)" indicates the field contains no data.

5. Press “Copy”.

3.9.14 Printing File Notes or Bookmarks

With Liberty Court Recorder and Liberty Court Player, you can print file notes or bookmarks. 

To print file notes or bookmarks, take the following steps:

1. Open the file in Liberty Court Recorder or Liberty Court Player.

2. If the Bookmarks window is not open, choose "View – Bookmarks" to open it.
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3. From the Bookmarks window, choose “File - Print”. The following dialog appears: 

4. In the “Include data” options, select the data you want to copy. "(empty)" indicates the field contains no data.

5. In the “Include area” options, select any of the following:

• Title of document – include a title at the beginning of the output. Select this option to customize the title.

• Header – include a header on each page of the output. Select this option to customize the header.

• Footer – include a footer on each page of the output. Select this option to customize the footer.

You can click the  button to include the file name within the title, header, or footer. You can click the 
button to include the current time within the title, header, or footer. 

6. Press "Format" to change the font, set options for page numbers, or to indicate whether bookmarks should
be printed in color.

7. Press "Page setup" to change the default page settings. 

8. By default, the output will be printed to your default printer. If you want to choose another printer or set other
printer options, press "Advanced print".

9. Press “Print”. 

3.10 Exporting a File

You can export a dcr file to a Windows Media file, wave file or AVI file so that you can play the file on a machine
that does not have the Liberty Court Player. You can also export a dcr file to another dcr file and choose which
bookmarks, types of bookmarks, video, file notes, attached files, and channels to export. This is useful when
you want to export a multi-channel file and exclude private notes. You can choose to export part of a file by
specifying a time range or export the entire file. You can also export a sealed recording with different options. 

If the file you export contains video then the video portion of the file is exported as well, as long as you are
exporting to another dcr file.

You can also export a dcr file, including bookmarks, audio, video, and attachments to PDF format. For more
information, see "Exporting a File to PDF Format".

You can also export a dcr file, including bookmarks, audio, and video, to PDF format. For more information, see
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"Exporting a File to PDF Format".

To export a dcr file, take the following steps:
1. Open the file in Liberty Court Player. 
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. Choose “File – Export”. The following dialog appears.

4. Specify the file name and location.
5. In the “Save as type” field, select the type of exported file: Windows Media, AVI, Wave, or DCR.
6. Optionally, you can select a previously used format from the drop-down list or use the “Change format”
button to change the file format.
7. By default, the entire file will be exported unless you have selected part of the file on the Selection Panel. You
can choose to export part of the file by pressing the "Change selection” button and specifying a start time and
an end time (using displacement times or absolute times) on the dialog below.
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8. By default, any sealed sections of the recording within the file, or part of the file, being exported, will be
deleted. You can use the “Change security” button to change this behavior. For more information, see "Working
with Sealed Recordings".
9. Use the “Channels” list to indicate which channels to export. You can select all channels or you can select
any combination of them. 
10. In the “Include data” section, select the data to be exported. Auto-bookmarks are automatically included.
Note that bookmarks and file notes cannot be exported to an AVI file.
11. Click Save.

When a file is exported, the channels are mixed into one. By default, Gate & Limiter technology is used to mix
the channels, and this helps preserve the level of loudness in the output file. You can change this behavior
using the “Advanced” button when setting Playback options in Liberty Court Player. 

3.11 Exporting a File to an Audio CD

You can export the audio data in a dcr file directly to an audio CD. This CD can then be used in any computer
CD-ROM drive or audio CD player. 

Liberty Court Player uses the Image Mastering API from Microsoft to export a file to an audio CD. This API is
included as part of Windows Vista. For Windows XP, you must install this API separately. You can download it
by searching the Internet for: WindowsXP-KB932716-x86-ENU.exe.  

To avoid creating a very large file and to facilitate playback, you can have the file automatically split based on
bookmarks or file size (in minutes). You can choose to export part of a file by specifying a time range or export
the entire file. You can also export a sealed recording with different options. 

To export a dcr file to an audio CD, take the following steps:
1. Open the file in Liberty Court Player. 
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. Choose “File – Export to Audio CD”. The following dialog box appears.
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4. Complete the fields described below.

Export to - Audio CD by burning – if this option is selected, Liberty Court Player creates an audio (CDDA) disc.
You should insert a blank CD-R/RW disc into your CD drive.

Export to - Audio files on hard drive – if this option is selected, Liberty Court Player creates files on the
selected drive. Select the file type, either wav or mp3. Normally, the default setting is acceptable.

Target drive/folder – specifies either the CD drive, when exporting to CD, or the folder where the files will be
created, when exporting to your hard drive. If this folder does not exist, you will be prompted to create it during
the export process. 

File names – displays the naming convention for the files to be created during export. This will be the name of
the file being exported followed by “__cdda__” followed by * to represent a sequential number. The extension
is .wav or .mp3. If the target folder already contains files that match this naming convention then you will be
asked if you want to replace them during the export process.

Selection – By default, the entire file will be exported unless you have selected part of the file on the Selection
Panel. You can choose to export part of the file by pressing the "Change selection” button and specifying a start
time and an end time (using displacement times or absolute times) on the dialog box below.
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Security - By default, any sealed sections of the recording within the file, or part of the file, being exported, will
be deleted. You can use the “Change security” button to change this behavior. For more information, see
"Working with Sealed Recordings".

Minimum file size is the minimum length, in minutes, of each file that is created during export. This value must
be from 1 to 120 minutes. The default value is 1 minute. This setting applies only when splitting the file based
on bookmarks.

Maximum file size is the maximum length, in minutes, of each file that is created during export. This value
must be in the range from 1 to 120 minutes. The default value is 5 minutes. A file is split once it exceeds its
maximum size regardless of whether the file is to be split based on bookmarks.

Split file based on bookmarks – select this check box if you want to split the file based on bookmarks. You can
have the file automatically split on any bookmark or only on docket bookmarks. Once a file has reached the
minimum file size specified above, the file will be split based on your bookmark setting or when the maximum
file size is reached, whichever comes first.

5. Click the Export button.

Exporting a file requires a lot of free space on your hard disk. For example, one hour of audio in WAV format
requires about 635 MB. The program first checks how much free hard-disk space is available and issues a
message if there is insufficient space. 

Exporting a file to a CD may take a long time. A progress bar indicates the status and the title bar shows the
percentage of the file exported.

When the export process completes, you can use CD-burning software to copy the files to a CD. If you are
using the CD Writing Wizard, then it starts once the files have been successfully created in the target folder.

3.12 Exporting a File to PDF Format

You can export the data in a dcr file to PDF format. This PDF file can then be browsed using Adobe Acrobat
Reader. You can choose to export part of a file by specifying a time range or export the entire file. The media file
can be created and saved separately from the PDF document so that the audio/video links will work properly
after you move the file onto a Windows Media Server folder to be streamed to the end users. 

All of the data, including file notes, bookmarks, audio, and video can be exported to the PDF file. If you export
any of the media, green arrows in the PDF file indicate bookmark positions, as shown below. You can click on
any of these arrows and playback will jump to that point in the file and launch Windows Media Player.
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To export a dcr file to PDF format, take the following steps:
1. Open the file in Liberty Court Player. 
2. If you want to export only part of a file, it is recommended you use the Selection Panel to select the fragment
you want to export. You can adjust this selection later in this process if you need to.
3. From the File menu, click Export to Adobe PDF. The following dialog box appears.

4. Specify the file name and location.
5. Optionally, you can use the “Change format” button to change the file format.
6. By default, the entire file will be exported unless you have selected part of the file on the Selection Panel. You
can choose to export part of the file by pressing the "Change selection” button and specifying a start time and
an end time (using displacement times or absolute times) on the dialog below.
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7. By default, any sealed sections of the recording within the file, or part of the file, being exported, will be
deleted. You can use the “Change security” button to change this behavior. For more information, see "Working
with Sealed Recordings".
8. In the “Include data” section, you can choose which media to export. You can export the audio and video, the
audio only, or neither the audio nor the video. Select the “Attached files” check box if you want to include
attached files when exporting the dcr file to PDF.
9. For the media file, you have the following options:
Embed into PDF file - select this option if you want the media file embedded in the resulting PDF document. 
Create separate WMA/WMV file – select this option if you want the media file to be created and saved
separately from the PDF document. Initially, it will be saved into the same folder as the PDF document with the
intention of later moving it onto a Windows Media Server folder to be streamed to the end users. In the "Prefix"
field, specify the URL associated with the media server folder and not the folder on the PC to which it is initially

saved. For example:mms://server/connection_point/subfolder. This enables the audio/video links in the PDF
document to work properly after you move the media file to the media server.
10. Click Save.

When a file is exported, the channels are mixed into one. By default, Gate & Limiter technology is used to mix
the channels, and this helps preserve the level of loudness in the output file. You can change this behavior
using the “Advanced” button when setting Playback options in Liberty Court Player. 

Exporting a file to PDF format may take a long time. A progress bar indicates the status and the title bar shows
the percentage of the file exported.

3.13 File Notes

You can add notes to a file after it has been recorded. You can use either Liberty Court Recorder or Liberty
Court Player to add or edit file notes.

To display notes associated with a new/open file, click the  button on the main toolbar or choose “View –
File Notes”.
Here is a sample display:
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You can use this text field to type any notes for a sound file.

You can use "View – Font" from the main window to change the font used in File Notes and bookmarks.

3.14 File Search Facility

Using Liberty Court Recorder or Liberty Court Player, you can search for text in DCR files and dockets. You can
search files and docket-specific fields, search by date or a date range, use a phonetic algorithm, show the
results as a list of files and a list of dockets, search for an exact phrase, specify a list of folders to search, and
so on. For example, you can search all files for "red corvette", Judge Simpson, or docket number 007.

This search facility uses the built-in Windows Indexing Service to enable faster searches. To use Index
Services, you must configure the PC on which the files are stored to index the DCR file location. For more
information, see "Setting Up the Indexing Service".

To search through files, take the following steps: 

1. Press the  button in the toolbar, or use "Tools – Find in Files". The following dialog appears:

2. In the "Find what" section, indicate what you want to find. The search results must match all of the criteria
you specify. To search for an exact phrase, enclose it in double quotes (e.g. "red corvette"). You can choose
from the following:

Text – specifies the text you want to find. 

More button - click this button if you want to search specific docket fields. Specify the data on which you want to
search in the relevant fields. You can use the drop-down lists to select previous entries you've made.

Date – you can have the search ignore dates, search for a specific date, or search in a date range. 

To clear the fields in the "Find what" section, click the "Clear fields" button.
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3. In the "Find where" section, indicate where you want the search to look. You can choose from the following: 

In files – enter the file-name mask for searching files. This is similar to using Windows Explorer for searching
files. You can use “*” to match any number of characters, and “?” to match a single character. The default value
is “*.dcr”, which means search for all files with an extension of "dcr”. Note that you can search only through files
with an extension of .dcr.

In folder – specifies one or more folders to search. You can type the names, separated by a semi-colon (;) or

click the buttons to the right. Click the  button to select one folder or click the "More" button to select multiple
folders. 

Include subfolders – select this option if you want the search to include subfolders of the starting folder. This
is the default.

4. Click the "Search Now" button to start the search.  You can interrupt a search at any time by clicking the
"Stop Search" button.

Reviewing the Results

The results of your search are shown at the bottom of the dialog box. The files that match your search criteria
are listed on the "List of Matching Files" tab. The dockets that match your search criteria are listed on the "List
of Matching Dockets" tab. You can sort any column by clicking on the column title. 

You can double-click on a line in your search results to open the associated file name or docket. 

Using Advanced Settings

If you don't want to use Indexing Service for faster searches, press the "Advanced" button and clear the "Use
Index Services for faster searches" check box.

By default, the file search facility uses a phonetic algorithm. This is an algorithm for indexing words by their
sound, when pronounced in English. On the "Advanced Find Settings" dialog box, you can choose not to use a
phonetic algorithm or switch the algorithm that is being used.

3.15 Analyzing a DCR File

Liberty Court Player has a built-in utility to analyze a DCR file and to validate its integrity. When problems occur
with a DCR file, Technical Support may ask you to analyze the file, by taking the following steps.

1. From the Help menu in Liberty Court Player, click "Analyze DCR File". The following dialog box appears.
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2. In the "DCR file to be analyzed" field, specify the full path to the file to be analyzed, or click the button to locate
and select the file.
3. Click the "Start" button.

When the analysis is complete, a dialog box appears with a summary of the results. If a problem is found
during the analysis, Technical Support may ask you to select "Use log file" and "Copy footer to file" on the
"Analyze DCR File" dialog box, rerun the analysis, and send them the resultant files. These files can help the

Technical Support Team determine and resolve problems associated with the DCR file.

3.16 Collecting Trace Information

To help identify and diagnose problems, Liberty Court Recorder and Liberty Court Player can collect diagnostic,
or trace, information.  You can set different types of traces when advised by the Technical Support Team. 

Technical Support may ask you to collect information for a problem, by taking the following steps.

1. From the Help menu, click "Debug". The following dialog box appears.

2. Technical Support will advise you which options to select on this dialog box and on the "Advanced Debug
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Settings" dialog box.

Each program collects and stores a limited amount of trace information in hidden files so that when a problem
does arise, there is already some trace information available. When you indicate that trace information is to be
stored in a file, the program copies trace information from a hidden file to the file you specify. 

The Mirroring trace file contains a subset of information in the General trace file and is used specifically for
diagnosing problems with mirroring. The Filter trace file contains information related to the Windows Indexing
Service.

You can use the View button to view system information or the contents of a trace file. If you want to copy a link
to one of these files, click the Copy Link to Clipboard button. You can then paste the link into a document,
email message, etc.

Trace information is automatically cleaned up. Information which is older than 7 days is automatically purged
from the General trace file; information which is older than 30 days is automatically purged from the Mirroring
trace file and the Filter trace file. You can use the Clear button to manually clear a trace file.

Note: When you install Liberty Court Recorder or Liberty Court Player, a folder called “Debug” is created in the
program’s installation directory. You should not delete this folder. If you accidentally delete it, you will need to
run the install program again and select the “Repair” option.

3.17 Setting Up the Indexing Service

The file search facility, invoked from "Tools - Find in Files", is designed to use the Windows Indexing Service for
faster searches. To use this service, you need to set it up to index the DCR files you store. Indexing Service is
designed to run continuously. After it is set up, all operations are automatic. 

To set up the Indexing Service for your DCR files, take the following steps:

1. From the Control Panel, choose "Administrative Tools - Computer Management”.

2. In the Computer Management tree, choose “Services and Applications - Indexing Service”. 

3. If the Indexing Service is running, press the Stop button (black rectangle) in the toolbar to stop it.

4. In the tree view, under "System", select “Directories”, as shown below:
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5. In the right panel, there is a list of directories to be indexed. If you are not currently using the Indexing Service,
delete each of these directories from the list. Select a directory, and from the right-click menu, select “Delete”.

6. Right click in the Directory list, and select "New – Directory". The following dialog appears.

7. Press the “Browse” button, and select the folder where DCR files are stored.

8. If your DCR files are stored in different directories, repeat steps 6 and 7 for each directory.

9. Start the Indexing Service by clicking "Indexing Service" in the Computer Management tree, and then press
the Start button on the toolbar. The first time this service is started, you are prompted to have it automatically
started each time Windows starts. You should answer “Yes”.

The Indexing Service locates the files in the path you have specified and indexes them. As new files are added,
they are automatically indexed. 

For more information, refer to the Windows online help for Indexing Service.



Using Liberty Court Player 123

Copyright (C) 2004-2011 High Criteria, Inc.

3.18 Disassociating DCR Files with a Liberty Court Program

DCR files are associated with either Liberty Court Recorder or Liberty Court Player. When you double-click on a
DCR file name in Windows Explorer, the associated program is automatically opened. If both programs are
installed, DCR files are automatically associated with Liberty Court Player.

If this association causes problems, you can disassociate DCR files from Liberty Court Recorder or  Liberty
Court Playerby taking the following steps:

1. Choose "View – Options".

2. Select the "General" tab. 

3. Press the “Advanced” button. The following dialog appears.

4. Clear the “Associate program with DCR files” check box.

3.19 Keyboard shortcuts

Use the shortcut keys for quick access to common commands.

You can use the following shortcut keys in the Main window:

Description Shortcut Key Button Menu

Open an existing DCR file Ctrl + O File – Open

Play Ctrl + P Playback – Play

Pause / continue Ctrl + U Playback – Pause

Stop Ctrl + T Playback – Stop

Play all channels Ctrl + 0 Playback –  Playing All

Channels

Play a specific channel Ctrl + (1-8) Playback – Playing Channel

(n)

Decrease the playback speed Ctrl + Shift + D Playback – Speed Play –

Decrease

Restore the normal speed Ctrl + Shift + N x1 Playback – Speed Play –

Normal 

Increase the playback speed Ctrl + Shift + I Playback – Speed Play –

Increase

Playback with automatic pauses Ctrl + Q Playback – Automatic Pauses

Change the autopause parameters Ctrl + Alt + Q Playback – Autopause

Parameters

Rewind to the beginning Ctrl + H Playback – Go To – Home

Left (one step) Ctrl + F Playback – Go To – Left

Right (one step) Ctrl + G Playback – Go To – Right

Go to end Ctrl + E Playback – Go To – End

Set the left selection boundary to the current

slider position

Ctrl + Shift + P Selection – Set Beginning of

Selection

Set the right selection boundary to the

current slider position

Ctrl + Shift + T Selection – Set End of

Selection

Export to WMV, WAV, AVI or DCR file Ctrl + Shift + E File – Export

Change configuration options Alt + F7 View – Options
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Show or hide the Bookmarks window Alt + F2 View – Bookmarks

Switch to the Thin View Alt + F5 View – Thin View

You can use the following shortcut keys in the Bookmarks window:

Description Shortcut Key Button Menu

Create a new bookmark F2 Edit – New Bookmark

Find text in bookmarks Ctrl + Shift + F Edit – Find

Move current position to previous bookmark Shift + F4 Position – Go to Previous

Move current position to current bookmark F4 Position – Go to Current

Move current position to next bookmark Ctrl + F4 Position – Go to Next
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pull     39, 48

push     39, 48

- Q -
quality     19, 23, 82



Liberty Court Recording System128

Copyright (C) 2004-2011 High Criteria, Inc.

- R -
read-only     16

record     41, 45, 46, 47, 48, 62, 78

record volume     41

recorder     13, 40

recording     19

redo     94

registration     16

Rehabilitation Act     62

remote     36

remove     17

replace     106

reposition     91

requirement     13

rescan     16

resolution     23

restore     28, 94

results     118

resume     45, 48, 78, 80, 81

rewind     85

- S -
script     26

scroll     87, 106

seal     36, 72, 87, 91, 103, 111, 113

search     118, 121

Section 508     62

security     36, 72

selection     78, 111, 113, 115

server     39, 48

service     121

setup     16, 17

shortcut     63, 123

shortcut key     56

shortcuts     56

shut down     31

slider     41

solution     13

sound card     66

sound quality     19

source     23

special     106

special character     102

speech     66, 82, 83

speed play     68, 78, 80, 82

SPEEX     19

split     113

standard view     60

start     17, 45, 48, 65, 78, 80, 85

start recording     34

startup     34, 69

status     50

step     85

step back     66, 80, 81, 85

step forward     85

stop     17, 41, 45, 48, 65, 78, 80, 85

streaming     39, 48

subfolders     118

substituting text     56

support     119, 120

switch     60

switch channel     85

symbol     102

synchronization     33, 50

system tray     31, 71

- T -
task bar     31, 71

temporary folder     31, 71

text     105, 106, 117, 118, 121

text file     108, 110

text substitution     41

thin view     31, 41, 78

time     33, 49, 50, 104

title     38, 73, 87, 94, 110

tone     83

toolbar     41, 73, 87

touch screen     35, 60

trace     120

trademark     16

treble     83

trial     16

- U -
UDF     28, 52

UDF format     30, 55

undo     94

uninstall     17

upgrade     16
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usage     38, 94

USB port     85

- V -
version     5, 6

video     23, 45, 48, 73, 80

video camera     23

video quality     45

video standard     23

view     35, 60

voice     66

volume     25, 82

volume slider     41

- W -
wave     111, 113

wave device     19, 25, 66

Windows Media file     111, 115

wizard     70, 86

wma     111, 115

wmv     111, 115

- X -
XML     94

- Z -
zoom     45
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